Chapter 1

Getting to Know Autodesk® 3ds
Max® 2013

Welcome to Mastering Autodesk 3ds Max 2013. Autodesk 3ds Max is the premier software pack-
age for 3D modeling, texturing, and animation, and it has many features specifically designed

to assist artists, architects, engineers, and designers in various disciplines in the realization of
their projects. It includes a Software Development Kit (SDK), which is used to develop plug-ins
that give the program additional functionality. 3ds Max Design is a different installation and, in
addition to having all the features of 3ds Max (except for the SDK), 3ds Max Design offers two
exclusive tools. The Lighting Analysis tool is used to help meet the Leadership in Energy and
Environmental Design (LEED) 8.1 certification standards. The Civil Visualization Extension is a
customized version of the Dynamite VSP plug-in for importing design data from AutoCAD Civil
3D or the Bentley MX design tools. In this book, we simply refer to the program as 3ds Max.

Autodesk 3ds Max 2013 provides users with cutting-edge rendering technology, easy-to-use
materials, improved interoperability with other related design and CAD software, enhance-
ments to modeling and animation tools, and better viewport interactivity than ever before.

This chapter introduces some of the special features of 3ds Max 2013, and then it gets you
started working with the 3ds Max interface.

In this chapter, you will learn to

Navigate and configure the viewports

Dock and float toolbars

* o

Copy objects and use the transform tools

Create a named selection set

*

Introducing the New 3ds Max 2013 Features

3ds Max 2013 is a notable release that extends the comprehensive features and functionality
with new, exciting capabilities, and it also updates many existing features. This is an important
release with a long list of improvements and additions that will greatly impact your projects,
whether you have been using 3ds Max for a number of years or are new to the world of 3D.
Each new version of 3ds Max incorporates fresh and exciting tools to enhance your capabili-
ties and workflow while also increasing the performance of the program on your computer
system. Utilizing these new features is a key to improving your skills and decreasing the time
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it takes to complete your projects. When you start the program, you are presented with the
Welcome To 3ds Max dialog box (see Figure 1.1), which includes links to Essential Skills Movies,
which teach many of the basic skills for using 3ds Max. It also includes a link to the “What’s
New” section of the Help documents, which explain the new features and links to the 3ds Max
Learning Channel on YouTube. Autodesk has done a tremendous job of regularly adding new
content to that channel. The Welcome To 3ds Max dialog box also provides you quick access to
start a new empty scene, the Open File dialog box, and a list of the last 10 files you have opened.
Note that if you don’t see this dialog box, you can go to the Help menu and click Essential Skills
Movies from there.

FIGURE 1.1 W] Welcome to 3d=
The Welcome To

?
3ds Max dialog box What do you want to do?

Learn 3ds Max Start Using 3ds Max

Essential Skills Movies Create a New Scene

_:_J 1. Zoom, Pan, and Roll: Navigation Essentials

Open a File
+3)

Recent Files

Learn More

Here, in no particular order, are some of the high points of 3ds Max 2013:

Modeless Array Dialog Box The Array dialog box is now modeless, meaning that you can
interact with the 3ds Max 2013 viewports while the dialog box is open, so that you can adjust
your views and see the preview of the array before you commit to it. This is a great ease-of-
use update for 3ds Max.

Egg Spline A new default shape called Egg has been added to 3ds Max. This allows you
to create a closed spline that resembles an egg. The spline shape includes a built-in Outline
parameter. This feature is in both 3ds Max 2013 and 3ds Max Design 2013, and it is primar-
ily used for support of the Autodesk Civil View Pipe Network tools that work only with 3ds
Max Design 2013.

Hair And Fur Hair And Fur has seen some updates for 3ds Max 2013.

MassFX The MassFX dynamics tools from NVIDIA have been updated and now include
cloth simulation, an updated Ragdoll (formerly Skeleton) system, and a Multi-Object Editor
to modify selections of objects more easily. Dynamics simulations can now take advantage of
and interact with standard 3ds Max Force space warps.
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gPoly gPoly is a new mesh format designed and optimized for the internal mesh format of
3ds Max, which eliminates the conversions needed from editable mesh and poly formats. The
result is faster animation when playing back high-resolution deforming objects.

Retime Tool The new Retime Tool works in the Curve Editor to help you adjust the anima-
tion of your scenes.

Track View The Track View menus have been updated to more closely resemble the anima-
tion editor found in Autodesk® Maya® software.

Autodesk Animation Store The Autodesk Animation Store appears at the bottom of the
Animation menu, and it opens in the Utilities tab. You can browse a selection of readymade
animation clips, purchase the animation clips directly from the site, and apply them to your
Biped-based characters.

Skin Modifier The Skin Modifier has been updated to sort bones automatically in ascend-
ing or descending order and provide better content filtering of bone names based on user-
entered criteria.

Workspaces 3ds Max 2013 users can now store multiple workspaces directly in a 3ds Max
2013 session. The workspaces are accessed from the Quick Access toolbar at the top of the 3ds
Max interface.

State Sets Found on the Rendering menu, state sets provide you with a way to keep and
interact with different states of scenes you are editing. State sets also directly integrate with
Adobe After Effects CS4 (32-bit) and CS5.x (64-bit only) so that you can send your 3ds Max
2013 scene to After Effects, make modifications, and then have those updates applied back to
3ds Max.

Viewport Layouts The Viewport Layouts toolbar appears on the 3ds Max 2013 interface
vertically along the left edge, and it allows you to store and quickly access different viewport
configurations set up in the scene.

Skylights Skylights in 3ds Max 2013 have been updated with Sky Color Maps that can use
HDR images, which can then be used to render illumination in all renderers and also cast
light and shadows in the Nitrous viewports.

Viewport Gradient Background The Nitrous viewports now use a default gradient as the
background of Perspective viewports. You will see this in the screen captures throughout
this book. The gradient colors can be changed in the Customize User Interface dialog box.

Nitrous Viewports The Nitrous viewports have been improved. The Perspective viewport
now has a gradient background that you can customize; performance on large scenes has
been improved; support for image-based lighting using the Skylight enhancements, viewport
depth of field, and new Facets and Clay shading modes have been added.

Slate Material Editor The interface for the Slate Material Editor has been improved. The
nodes that are displayed in the Parameter Editor now have a dotted line surrounding them
in the View windows; context menus work with multiple items selected. You can now get
the materials from a selected object brought to the active View window, using the Get From
Selected feature of the Material menu. There are new options that make working with mate-
rial libraries much easier.
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Render Setup Dialog The Render Setup dialog has been improved with a drop-down
menu that allows you to quickly select among Production, Iterative, ActiveShade, and
Network Rendering.

iray Renderer The NVIDIA iray renderer for 3ds Max 2013 has been upgraded to iray 2.1.

mental ray Renderer The NVIDIA mental ray rendering engine has been updated to men-
tal ray 3.10.

FBX File Link Enhancements The File Link Manager is now capable of directly linking
Revit Architecture (RVT) files, and new Link options can be found by going to Application
menu > Import.

Improved Geometry Support 3ds Max 2013 takes advantage of Autodesk DirectConnect to
support importing many different data formats into 3ds Max 2013 as Body objects, including
STEP files, SolidWorks, Pro/E, CATIA (v4 and v5), and IGES files (which no longer come in as
NURBS objects).

Send To Menu The new Send To feature on the Application menu allows you to send files
directly to Maya, Autodesk® Softimage®, Autodesk® MotionBuilder®, Autodesk® Mudbox®,
and Autodesk® Infrastructure Modeler software if you are running one of the Autodesk
suites.

Maya Interaction Mode For 3ds Max 2013 users who are accustomed to using Autodesk
Maya, the new Maya Interaction mode adjusts 3ds Max 2013 to work with viewport controls
and keyboard shortcuts from Maya.

Lightscape Compatibility Removed If you are a previous user of 3ds Max, 3ds Max
Design, or 3ds VIZ and Lightscape, be aware that all Lightscape compatibility, utility, and
material features have been removed from 3ds Max 2013.

Product Updates 3ds Max 2013 also ushers in a new update scheme. Instead of having
confusingly numbered Hot Fixes and service packs that you have to make sure to install in
the correct order for 3ds Max to function properly, fixes for 3ds Max will now come out as
sequentially numbered Product Updates. These Product Updates are easy to install in the
right order and will ensure that 3ds Max is working properly. Make sure that your installa-
tion of 3ds Max 2013 has all available Product Updates installed before proceeding with the
exercises in this book.

For more information about the new features and improvements in 3ds Max, go to the

“What’s New in Autodesk 3ds Max 2013” section of the Help system. You can also find informa-
tion on the Autodesk website or the Autodesk media and entertainment forums called the Area
(area.autodesk.com).

Getting Started with Autodesk 3ds Max

Although many of 3ds Max’s components are typical for a Windows program, quite a few
are unique to 3ds Max; therefore, a solid understanding of them is essential to using the
program effectively. To begin exploring the 3ds Max 2013 interface, start the program by
doing one of the following:

¢ Double-click the 3ds Max 2013 icon on the Desktop.
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¢ Choose Start > All Programs > Autodesk > Autodesk 3ds Max 2013 > Autodesk 3ds Max
2013.
If you are on a 64-bit Windows system, you will see the 64-bit suffix on the folder and icon
names.
You'll see a variety of components in the 3ds Max 2013 window (see Figure 1.2). Some may be
familiar to you while others may not.

FIGURE 1.2
The standard 3ds
Max 2013 window

THE LARGE ICONS OPTION

The images in this book use the default Large Icons option to display the toolbar buttons better.
To deactivate this option and use the smaller icons, thereby gaining some much-needed viewport
workspace, choose Customize > Preferences to open the Preference Settings dialog box. In the Ul
Display group of the General tab, deselect the Use Large Toolbar Buttons option, and then shut
down and restart 3ds Max for this setting to take effect.

At the top, you see a typical Windows menu bar and the 3ds Max Main Toolbar. Depending
on your default settings, you may also see up to nine more floating or docked toolbars contain-
ing additional 3ds Max tools. Beneath the Main Toolbar is the Graphite Modeling Tools tool-
bar. In the center, you see the viewport area, which currently shows the Top, Front, Left, and
Perspective viewports. At the lower-right corner of the screen, you find the viewport naviga-
tion tools for adjusting your views in the current viewport. Also included are the time controls
for creating and playing animations, the prompt line and status bar, and the MAXScript Mini
Listener (for creating macros). On the left side of the window above the MAXScript area is the
new Viewport Layout Tabs toolbar. On the right side of the user interface is the Command
panel, which contains nearly all the tools you'll use to create and edit objects in 3ds Max. Let’s
take a closer look at each of these components. 3ds Max often provides several methods, includ-
ing toolbars, Command panels, menus, and shortcuts, for accomplishing the same task.
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Touring the Interface

3ds Max offers a wealth of tools, and their sheer number can be overwhelming. To get a basic
understanding of the 3ds Max window, we’ll present each of the window components individu-
ally, starting with the Menu Bar.

The Menu Bar

At the top of the screen is the Menu Bar. Here you'll find the typical Windows commands for file
maintenance, as well as commands specific to 3ds Max.

Standard to 3ds Max 2013 is the Application button (see Figure 1.3), which replaced the tradi-
tional File menu in the 2010 release. The Application button is a graphical representation of the
tools from the traditional File menu, including opening and saving files, importing, exporting,
and referencing files. The Application button is also where you can set a project folder, access
the Asset Tracking tool, and check statistics about the current file. If you are more comfortable
using the traditional File menu, you can restore it to the 3ds Max interface using the dialog box
that appears when you select Customize > Customize User Interface.

FIGURE 1.3
The Application
button

The options in the Menu Bar are organized the same way as they are in most Windows
applications. Clicking an option issues a command, and you're expected to take some action. An
option that’s followed by three periods, called an ellipsis, opens a dialog box, usually to allow
you to make changes to settings related to the option. An option with a right-pointing arrow
displays more options in what is called a cascading menu, as shown in Figure 1.4. Depending on
your version of Windows, user settings, and if you have a pen tablet attached to you system,
your menus may cascade to the left or to the right.

FIGURE 1.4 Tools  Group  Views  Create  Modifiers Animation
A typical cascading 3 Box Standard Primitives
menu L Cone Extended Primitives

Sphere AEC Objects

GeoSphere I} Compound

Cylinder Particles

Tube Patch Grids

Torus MNURBS

Pyrarmid Dynamics

Teapot mental ray

Plane

Shapes
Extended Shapes
Lights

Cameras
Helpers

SpaceWarps
Systems
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Try out the Menu Bar by taking a look at the Units Setup dialog box:
1. Choose Customize > Units Setup. The Units Setup dialog box displays.

2. Select the US Standard radio button, and make sure that Feet w/Decimal Inches is
selected below it and that the Inches radio button is selected for Default Units, as shown
in Figure 1.5.

FIGURE 1.5
Defining the units
in the Units Setup
dialog box

3. Click the System Unit Setup button at the top of the dialog box, and you will see the
System Unit Setup dialog box shown in Figure 1.6. Make sure 1 Unit is set to 1.0 Inches.
Do not change anything else in the System Unit Setup dialog box, and click OK twice to
close both dialog boxes.

FIGURE 1.6
The System Unit
Setup dialog box

By setting the System Unit Setup options, you ensure that you'll be working with the same
units that are discussed in this book.

7
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REVERTING TO THE STARTUP LAYOUT

3ds Max 2013 is something of a chameleon. It can change its appearance depending on the focus of
your modeling needs. Users of 3ds Max 2013 will see tools designed more for the game and enter-
tainment industries, while users of 3ds Max Design 2013 will see an interface and defaults geared
more toward architectural and design visualization. If your 3ds Max 2013 window doesn’t look the
way it does in the figures in this book, choose Customize > Revert To Startup Layout. You’ll see a
warning message telling you that any user interface (Ul) changes you have made will be lost. Click
Yes to set up your 3ds Max windows to match the interface you see in this book. You can also reload
Custom Ul schemes to reset the interface or use the Custom Ul and Defaults Switcher to accomplish
the same thing, plus more. See the “Working with the Custom Ul And Defaults Switcher” section
later in this chapter for more information on this topic.

The Quick Access Toolbar

Just to the right of the Application button is the Quick Access Toolbar, shown in Figure 1.7,
another standard feature in 3ds Max 2013. As its name implies, it provides quick access to a
number of useful commands, including New Scene, Open File, Save File, Undo and Redo Scene
Operation, the Select Project Folder Browser, and the Workspaces tool.

FIGURE 1.7 = ‘ )= (2 = ] Workspace: Default - |5
The Quick Access ! Edi ools  Group  Views Create  Modifiers |
Toolbar _ '\ cE-t i’:‘}

Click the Undo Scene Operation button to undo your last actions, up to 20 by default, or
the Redo Scene Operation button to redo any undone actions. Clicking the drop-down button
next to either the Undo or Redo Scene Operation button opens a list of actions from which you
can select.

You can customize the Quick Access Toolbar by clicking the down-arrow icon at the far right
of the toolbar.

The Information Center Toolbar

All the way across the screen at the upper-right corner of the interface, near the traditional
Windows Minimize, Maximize, and Close buttons, is the Information Center Toolbar, as shown
in Figure 1.8. The Information Center Toolbar provides a search function for 3ds Max top-

ics in the online Help files and on the Autodesk website; the Subscription Center (if you have
Subscription Center access); the Communication Center, where you'll receive notices of program
updates and other relevant announcements; a Favorites panel, where you can store links to
commonly-accessed websites; and pages and elements from the 3ds Max Help menu. You can
use the right-facing arrow button at the left end of the Information Center Toolbar to minimize
the Search field if you wish.

FIGURE 1.8

The upper-right
corner of the 3ds
Max 2013 interface

i Type a keyword or phrase




TOURING THE INTERFACE

The Main Toolbar

Just below the Menu Bar is the Main Toolbar. The tools on this toolbar offer tooltips, which are
exposed when your cursor pauses over them, to help you identify their purpose.

The first set of tools, shown in Figure 1.9, is for linking and selecting objects. The two link-
ing tools, one for linking and the other for unlinking, cause one object to move, rotate, or scale
based on commands applied to another object. The third linking tool, the Bind To Space Warp
tool, can be used to attach objects and space warps to each other. The selection filter allows you
to limit what can be selected with the cursor. The selection tools let you select objects by click-
ing them or by selecting them by name. You can also specify the method for selecting objects
by using a selection window, which lets you indicate a selection by placing a rectangle, circle, or
other border around the objects.

FIGURE 1.9

The Linking and
Selecting tools on
the 3ds Max 2013
Main Toolbar

To the right of the selection tools are the transform tools, shown in Figure 1.10. This set of
tools lets you select and move, rotate, and scale objects. You can also choose the reference coor-
dinate system; set the center of the transform using the pivot point options; toggle the ability to
manipulate certain objects, modifiers, and controllers by clicking and dragging visible manipu-
lators in the viewports; toggle the keyboard shortcut overrides; use different snap options; work
with named selection sets; and use tools to mirror and align objects.

FIGURE 1.10
The 3ds Max
transform tools

The next group of tools to the right, shown in Figure 1.11, includes access to the Layer
Manager, the Graphite Modeling Tools display toggle, the Track View Curve Editor, the
Schematic View tools, and the Material Editors and rendering tools. The Layer Manager gives
you control over all of the settings for layers in your scene and the objects contained in those
layers. The Graphite Modeling Tools are a complete set of more than 100 tools to improve creat-
ing and editing poly objects within 3ds Max. (Note that the Graphite Modeling Tools are the
first 3ds Max tools available on a customizable ribbon interface. You will explore the Graphite
Modeling Tools interface in Chapter 4, “Editing Meshes and Creating Complex Objects.”) The
Track View - Curve Editor displays your scene information as curves on a graph that indicates
the position, rotation, and scale of objects in your scenes over time. Dope Sheet mode displays a
graph of the keys of your animation over time. The Schematic View tools provide a visual graph
and control how all the elements of your scene are linked. The Materials tools give you control
over the appearance of objects by defining and applying their surface properties. With these
tools, you can create color, texture, opacity, and other material characteristics and then apply
these characteristics to objects in your model. You can also open the Render Setup dialog box,
select the render type, view the last rendered frame, and quickly access the production renderer
or the ActiveShade renderer.

9
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FIGURE 1.11

The Layer Manager,
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Rendering tools

The rendering tools give you control over the image output of your 3ds Max scene. Unlike
output from most applications, output from 3ds Max 2013 is most likely to be image or animation
files or models and resources for exporting to real-time game engines. The rendering tools let
you set the type and size of output, from single, large-format stills to video-ready animations.

WORKING ON A LOWER-RESOLUTION SYSTEM

If you’re working with a screen resolution less than 1280 x 1024, you will not be able to see all the
tools on the Main Toolbar. Some of the tools are off the screen to the far right. To access these tools,
place the cursor on the toolbar so that a hand icon appears, and then click and drag the toolbar to
the left. If you have trouble with this, move your cursor under one of the drop-down lists on the
Main Toolbar to access the pan (“hand”) tool. The hidden tools will emerge. You can also click the
Rendering menu item to access all the rendering tools. The smallest supported screen resolution
for the Ul'in 3ds Max 2013 is 1024 x 768, but the recommended resolution is 1280 x 1024 or higher.
All the screenshots presented in this book use a 1680 x 1050 resolution.

Docked and Floating Toolbars

In addition to the Main Toolbar, you may see several floating toolbars sitting on top of the view-
port. These toolbars may be hidden by default. You can open hidden toolbars by right-clicking
a blank part of any open toolbar. A context menu will appear listing the available toolbars. Let’s
take a quick look at the floating toolbars.

1. Right-click a blank area of the Main Toolbar, and click any of the toolbar items that do not
have a check mark next to them, as shown in Figure 1.12.

FIGURE 1.12
Right-click and
select a toolbar. Customize...

Command Panel
Main Toolbar

Auxis Constraints h

Layers

Extras

Render Shortcuts

Snaps

Animation Layers
Containers

MassFX Toolbar
Viewport Layout Tabs
Graphite Modeling Tools
Brush Presets
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2. Repeat the process until all the floating toolbars are exposed.

All the toolbars float over the viewports and have titles such as Layers, Render Shortcuts,
Snaps, Axis Constraints, and Extras. As with most toolbars, you can dock these floating toolbars
to the side or hide them altogether to gain better access to objects in the viewports. The toolbars
can be resized by clicking and dragging any of their edges.

CONSIDER A DUAL-SCREEN SYSTEM

In 3ds Max and many other graphics programs, screen space is always at a premium. You can use
a two-monitor (or even three-monitor) system to help unclutter your primary screen workspace.
Simply move items such as floating toolbars, the Material Editor, Curve Editor, Rendered Frame
Window, and so forth to the second monitor, freeing up as much screen real estate as possible.

Layers are like overlays that help you organize the objects in your model. If you are an
AutoCAD or Adobe Photoshop user, you already have an idea of how layers work. You'll learn
more about layers in Chapter 10, “Organizing Objects and Scene Management.” The Layers tool-
bar is shown in Figure 1.13.

FIGURE 1.13
The Layers toolbar

Render shortcuts contain predefined render settings, such as resolution and output file type,
that are used to create content from your 3ds Max scenes. The Render Shortcuts toolbar, shown
in Figure 1.14, is where you will find the tools for saving and storing your preset values. You'll
learn about rendering in Chapters 9 through 15.

FIGURE 1.14
The Render
Shortcuts toolbar

Snaps are features that control where the cursor jumps to, adding a degree of precision to
your scene, when the cursor is near a characteristic in the scene. Using snaps, you can easily
move the corner of one object to the midpoint of another or nearly any other characteristic com-
bination. The Snaps toolbar is shown in Figure 1.15.

FIGURE 1.15
The Snaps toolbar

Objects are frequently transformed (moved, rotated, or scaled) along a particular axis, or
direction, relative to the object or the scene. This functionality is usually utilized through the
transform gizmos, onscreen tools used to facilitate the transforms. The Axis Constraints toolbar,
shown in Figure 1.16, allows you to control which axis constraints are used in transformations
and if constraints are considered when Snaps are enabled.

FIGURE 1.16
The Axis
Constraints toolbar

11



12

CHAPTER 1 GETTINGTOKNOW AUTODESK®3DS MAX®2013

The Extras toolbar (Figure 1.17) contains tools that don't fit cleanly into other categories. With
the AutoGrid button, you can turn on a creation grid relative to the surface of any object in the
scene. You can also create an array (numerous, precisely placed clones) of objects in matrices,
along a path or at equal intervals.

FIGURE 1.17
The Extras toolbar

Several tools found within 3ds Max utilize a paint brush analogy in their implementation.
The location and intensity of the effects are determined by how the brush cursor is dragged over
an object’s surface. The Brush Presets toolbar, shown in Figure 1.18, gives you access to the stan-
dard brushes and the Brush Preset Manager so that you can modify and save a brush’s param-
eters. This toolbar is grayed out unless a tool that utilizes it is active.

FIGURE 1.18
The Brush Presets
toolbar

The Animation Layers toolbar (Figure 1.19) lets you access tools that control the layering of
objects” animated parameters. Layering allows you to designate which animated features are
enabled and which are not, allowing for many possible combinations.

FIGURE 1.19
The Animation
Layers toolbar

Large scenes and projects can become very complicated quickly. Containers help you orga-
nize assets by combining them into groups. They can be loaded and unloaded at will to reduce
the size of files and how much information is active at one time. By refreshing the link to a con-
tainer, you can help coordinate data and project changes among project teams. By limiting write
access to data files, you can protect project scene files. Use container proxies to reduce the size of
the file while still seeing the container contents. The Containers toolbar is shown in Figure 1.20.

FIGURE 1.20
The Containers
toolbar

Interactions between objects (for example, rigid object collisions, cloth surfaces, ragdolls, and
jointed constraints) can be difficult to animate manually. Using MassFX, a dynamics simulation
toolset, you can quickly create simulations that account for properties such as gravity, friction,
and wind. The MassFX Toolbar is shown in Figure 1.21.

FIGURE 1.21
The MassFX toolbar
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The Graphite Modeling Tools, shown in Figure 1.22, are typically docked right under the
Main Toolbar, and they provide context-sensitive access to a number of tools and features that
enhance the poly-modeling capabilities of 3ds Max.

FIGURE 1.22 -
The Graphite Polygon
Modeling Tools

The Viewport Layouts tabs bar, shown in Figure 1.23, is docked by default to the left edge of
the 3ds Max 2013 interface, and it provides access to the standard viewport layouts and allows
you to save different viewport layouts in your 3ds Max files to enhance your workflows.

FIGURE 1.23
The Viewport
Layouts tabs bar

You can dock the floating toolbars or float the docked toolbars. Try the following exercise to
see how to change the location of toolbars:

1. Click and drag the title bar of the Layers toolbar so that the toolbar is below the Main
Toolbar. The Layers toolbar appears ghosted as a horizontal outline just before you
release the mouse button.

2. When the outline is in the position shown in Figure 1.24, release the mouse button. The
Layers toolbar is now in a docked position.

FIGURE 1.24

Docking the Layers Modifiers  Animation  Graph Editors  Rendering

Main Toolbar

toolbar under the % g e () B view  ~JOLJ ol + |

=

3. Click and drag the Extras toolbar, and dock it just to the right of the Layers toolbar (also
just under the Main Toolbar), as shown in Figure 1.25.

FIGURE 1.25
Docking the Extras
toolbar
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4. Right-click the two vertical lines (called the foolbar handle) on the left side of the Extras
toolbar to open the context menu shown in Figure 1.26.

FIGURE 1.26 e —
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5. Select Float from the context menu. The Extras toolbar returns to its floating position.
Other ways to float a toolbar include dragging the toolbar by its handle down into the
viewport or double-clicking the handle.

6. Toolbars can be docked on any side of the viewports. However, you should avoid docking
toolbars to the left and right sides of the interface if the toolbars have drop-down lists;
otherwise, the lists will not appear. Select the Axis Constraints toolbar, and dock it to the
left side of the user interface (Figure 1.27).

FIGURE 1.27
Toolbar docked left

7. Select the remaining floating toolbars, and dock them on the top, right, or left edge of the
viewport.
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In this brief exercise, you learned how to dock and float toolbars and how to access the con-
text menu where you can toggle the toolbars on and off. Most of the toolbars aren’t required
in the early chapters of this book, and they occupy a portion of available screen space. You can
hide or float the toolbars however you like.

Toolbar Flyouts

You may have noticed that some of the tools in the Main Toolbar show a small triangle in the
lower-right corner of the tool’s icon (see Figure 1.28).

FIGURE 1.28
Flyout arrow )

That arrow indicates that the tool is one of several offered in a flyout. A flyout is like a graphi-
cal version of options in a menu bar. If you click and hold a tool that’s part of a flyout, you see a

set of additional, similar tools appear. For example, if you click and hold the Select And Uniform
Scale tool, two additional tools appear, as shown in Figure 1.29.

FIGURE 1.29
The Select And
Uniform Scale fly-
out menu

Once you select an option from a flyout, it becomes the default button that you see in the
toolbar.

The Viewports

At the center of the window are the viewports (see Figure 1.30). You'll be doing most of your
modeling work in a viewport. In a blank file, the viewports show a grid that you can use as a
reference for orientation and size.

FIGURE 1.30
A typical viewport
configuration

15



16

CHAPTER 1 GETTINGTOKNOW AUTODESK®3DS MAX®2013

If you look in the lower-left corner of the viewport, you will see the World Axis Tripod that
indicates the orientation of the X-, Y-, and Z-axis. The World Axis Tripod helps you get your
bearings when you are looking at camera and perspective views.

Currently, there are four viewports named Top, Left, Front, and Perspective, as indicated by
the labels in the upper-left corner of each viewport. You can also tell that the Perspective view-
port is different from the others by the way the grid squares get smaller and converge in the
distance, and it has a gradient background. As you'll see toward the end of this chapter, you can
configure and view your model in a variety of ways, depending on your needs.

Tools for Working with the Viewports

At the bottom of the window are several other options that are grouped into six sections

the status bar, the prompt line, the time controls, the time slider, the track bar, and the viewport
navigation tools (see Figure 1.31). Most of these tools affect the viewport, either by modifying
the display of the viewport directly or by affecting the way you interact with objects within the
viewport.

FIGURE 1.31 Mini Curve
The bottom sec- Editor
tions of the 3ds Max

Time slider Track bar
2013 window ‘

MAXScript Prompt Status Animation Keying Animation Playback
Mini Listener line bar Controls Controls

Viewport navigation tools

The viewport navigation tools give you control over the main graphic display in the center
of the window. With these tools, you can zoom and pan over the display as well as alter the
viewpoint of your model. You can also switch between multiple views and a single view. Try the
following;:

1. Right-click in the Perspective viewport to make it the active viewport, and note that it is
now surrounded with a gold border; then click the Maximize Viewport toggle in the far
lower-right corner of the window. This is a tool you'll be using often. You can also press
Alt+W on the keyboard.

The graphic display changes to display a single viewport showing only the viewport that
had the gold border, the Perspective viewport in this case.

2. Click the Maximize Viewport toggle to divide the viewport area into four individual
viewports again.

3. Click the upper-right viewport, labeled Front. Notice that the border of the Front view-
port becomes highlighted in yellow.

4. Click the Maximize Viewport toggle again. Now the Front viewport fills the graphic area.
Notice how you can quickly expand the view of a viewport to see more detail.

5. Click the Maximize Viewport toggle again to return to a four-viewport layout.
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6. Place your cursor at the intersection of the four viewports until it changes to a crossed-
arrows cursor. Click and drag to resize all viewports simultaneously, as shown in
Figure 1.32. You can also place the cursor between just two viewports to resize the view-
ports in only one direction.

FIGURE 1.32
Resize the
viewports by
dragging their
intersection.

7. Right-click the border between two viewports, and choose Reset Layout from the context
menu to return to the default layout, as shown in Figure 1.33.

FIGURE 1.33
Reset Layout option

You've just seen how you can display a single viewport or expand the graphic area into mul-
tiple viewports showing the Top, Front, Left, and Perspective viewports. Several other views
and viewport arrangements are available, as you'll see later in this chapter.

USING SHORTCUT KEYS TO SWITCH VIEWPORTS

You can set the current, active viewport to display a top, front, or left side view by pressing the T,
F, or L key. You can also press B for the bottom view. Pressing P will display the perspective view,
and pressing U will display an orthographic user-defined view. If you have added a camera, you
can press Cto select from alist of camera views. The hotkeys of R for right view and K for back have
been changed from the defaults in previous versions of 3ds Max and now are used for cycling Scale
options and Set Keys respectively. You can easily assign your own hotkeys to commands.
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To the left of the viewport navigation tools are time controls. These tools give you control
over the animation functions of 3ds Max. Here you can set your creations in motion by selecting
the length of time for your animation as well as set the precise location of objects within that
time frame.

Near the bottom center of the interface is a large button with the symbol of a key on it and
two smaller buttons to the right that are used to create animation keyframes, called keys, as
shown in Figure 1.34.

FIGURE 1.34
The animation and
time controls
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The long horizontal elements across the bottom of the viewport are the time slider and
track bar, which are used for animation. You can hide the track bar to save space on the screen.
Choose Customize > Show UI > Show Track Bar to toggle this part of the interface off until
you're ready to make animations. For the exercises in this book, leave the track bar visible.

Just to the left of the animation controls are the transform type-ins, shown in Figure 1.35.
This area displays the location of your cursor in X, Y, and Z coordinates. It also displays other
types of data, depending on your current activity. For example, if you're rotating an object, the
coordinate readout displays the rotation angle of the object being rotated. If you're scaling the
data, these text boxes will show percentages.

FIGURE 1.35
The transform
type-in
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In addition to the transform type-ins, there is a Grid panel, shown in Figure 1.36, which may
be hidden to the right if your display is set to low resolution. To find it, if necessary, place the
cursor on the vertical bar just to the left of the prompt line until you see a double-pointed arrow.

FIGURE 1.36
The Grid panel

When you see the arrow, click and drag to the left. The Grid panel will be revealed to the
right of the transform type-ins.

The Grid panel displays the default setting for the grid size in the current scene. You can hide
or display a grid in the active viewport by pressing the G shortcut key. Right-click the Snaps
toggle, Angle Snap toggle, or Percent Snap toggle in the Main Toolbar, and then click the Home
Grid tab of the Grid And Snap Settings dialog box to set the grid spacing and other grid param-
eters, as shown in Figure 1.37.

FIGURE 1.37
Grid and Snap
Settings
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Finally, to the far left at the bottom of the 3ds Max window is the MAXScript Mini Listener,
as shown in Figure 1.38. MAXScript is a programming language that allows you to create cus-
tom applications or macros in 3ds Max. A macro contains a prerecorded series of instructions.
The MAXScript Mini Listener serves two functions the pink area displays your activity when
the MAXScript MacroRecord function is turned on, and the white area provides a space where
you can enter commands using the keyboard.

FIGURE 1.38
The MAXScript Welcome to MAXScript.
Mini Listener

Getting to Know the Command Panel

You'll be using the Command panel for most of your work in 3ds Max. If you're an experienced
AutoCAD user, you might think of the Command panel as the equivalent of the AutoCAD com-
mand line; it’s a single entry point for most of the program’s functions. The Command panel
offers nearly all the tools for creating and editing in 3ds Max.

Across the top of the Command panel, you'll see a set of six tabs, each displaying an icon, as
shown in Figure 1.39.

FIGURE 1.39
The tabs at the top
of the Command
panel

From left to right, the tabs are Create, Modify, Hierarchy, Motion, Display, and Utilities. If
you place your cursor on a tab, you'll see a tooltip displaying the name of the tab. When you
click a tab, the functions relating to the tab appear in the rest of the Command panel. Here’s a
brief rundown of what each tab offers:

Create This tab allows you to create two- and three-dimensional objects. You can also cre-
ate light sources, cameras, and helper objects that are used to determine distance and rela-
tionships between objects. Light sources, cameras, and helpers are objects that don’t appear
when your view is rendered.

Modify This tab gives you control over the dimension, shape, and parameters of your
objects. On it, you'll find tools to extrude, twist, and bend your objects. You can also control
methods for applying material definitions to objects (called mapping coordinates) on this tab.

Hierarchy This tab offers a set of tools aimed primarily at animation. The options on this
tab let you build relationships between objects to simulate joint movement or to constrain the
motion of one object in relation to another. It also offers a way to control the location of an
object’s pivot point.

Motion This tab also gives you control over animation. Here you can control the actual
motion or parameter change of objects over time and view the objects’ trajectories.

Display This tab lets you turn the visibility of objects on or off in your model. There may be
times when you don’t want a particular object visible while you render your model or while
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you're editing a complex model full of objects. Display lets you temporarily hide objects from
view or lock them out from being selected. Objects can be hidden individually or by category.

Utilities This is a kind of catchall tab that provides access to special features and plug-ins.
Here you find the Camera Match utility, which lets you match your model view to a photo-
graph. You can also get access to the MAXScript customization features on this tab.

FLOATING AND HIDING THE COMMAND PANEL

You can move the Command panel just like any other toolbar, or you can close the panel entirely by
clicking the Close button (the one with the X, in the upper-right corner of the window) when the
panel is floating. To bring the Command panel back, right-click the blank area of any toolbar and
then select Command Panel from the context menu. You can also right-click the Command panel’s
title bar to dock the panel on the left or right side of the screen or minimize the Command panel to
autohide it when it’s not in use.

Understanding the 3ds Max Tools

A few ways of working in 3ds Max are a bit unusual for a Windows program. In this section,
you'll explore the Create tab of the Command panel as a way to understand some of the quirks
of 3ds Max. There aren’t many, but understanding them now will make it easier for you to learn
how to use the program.

GETTING TO KNOW SCROLLING PANELS AND ROLLOUTS

3ds Max 2013 has a rich set of creation and editing tools — so many, in fact, that 3ds Max’s pro-
grammers had to come up with a way to get to them easily without making the program too
arcane. Two of these tools help you navigate its interface: the scrolling panel and the rollout. A
scrolling panel is an area that can be scrolled up or down using a pan cursor. A rollout is a set of
tools that can be opened or closed, much like a drawer in a dresser. Let’s start by looking at how
a scrolling panel works:

1. Click the Create tab of the Command panel. Notice the row of icons just below the title of
the tab, as shown in Figure 1.40. These icons are buttons, or tools, that offer different cat-
egories of objects.

FIGURE 1.40
The categories
under the Create
tab

2. Place the cursor over the tool that looks like a movie camera. Notice that a tooltip dis-
plays, offering the name of the tool.

3. Click the Cameras tool. You see the options change below the tools, as shown in
Figure 1.41.
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FIGURE 1.41
Click the Cameras
tool

4. Click the Target button. A set of additional options appears. Although it may not be obvi-
ous, these options extend beyond the bottom of the Command panel.

5. Move your cursor down to a blank spot in the Command panel. The cursor changes to a
hand.

6. Click and drag upward with your mouse. Notice that the options in the Command panel
scroll up, following the motion of your mouse. This is an example of a scrolling panel.
This scrolling action exposes the rest of the options in the lower portion of the Command
panel. Release the mouse button at any time once you've seen how this scrolling action
works.

7. Place your cursor on a blank area again so that the pan cursor displays. Then click and
drag down to view the Target and Free buttons under the Object Type bar.

8. You can also scroll the Command panel by dragging the dark-gray slender vertical scroll
bar on the right side of the Command panel, as shown in Figure 1.42. Try both of these
methods.

FIGURE 1.42
Scroll the contents
of the Command
panel

9. Another way to see more of the Command panel is to increase its width by dragging
the vertical border between the Command panel and the viewport. Position your cursor
along this edge, drag to the left, and expand the Command panel to two and then three
columns.

10. The advantage to having a two- or three-column Command panel is obvious — you
can see all the controls within the Command panel at once. The disadvantage is equally
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apparent — the viewport area becomes much smaller. Drag the Command panel back
to one vertical column to give yourself the maximum amount of screen space. In a one-
monitor system, it’s better to scroll within the Command panel than to sacrifice valuable
viewport space.

11. Hover the mouse near the top of the Command panel, and you will see the cursor change.
Then right-click and choose Minimize. The Command panel is reduced to a single, nar-
row border tab. Move your cursor over it to reveal it; move it off it to autohide. This works
really well if you have a two- or three-column format.

In this exercise, you learned that you can change the entire set of options by clicking a single
tool. You can also see that the set of tools can extend beyond the bottom of the Command panel.
You can scroll the options up or down within the panel in several ways. This allows 3ds Max to
offer a wide variety of options within the limited space of your display.

The Main Toolbar also acts like a scrolling panel whenever a portion of the toolbar extends
beyond the screen area. For example, if your screen resolution is 1024 X 768, a portion of the
Main Toolbar isn't visible to the right of the screen. If you place the cursor on a blank area of the
Main Toolbar, it turns into the pan cursor. You can then click and drag to the left to display the
additional tools.

When you clicked the Target button in step 4 of the preceding exercise, a set of options
appeared under a bar labeled Parameters. There are three other bars, labeled Depth Of Field
Parameters, Object Type, and Name And Color. Notice the minus () sign to the far left of these
bars. These bars display the titles of the rollouts. They let you open and close a set of options to
get them out of the way or to roll them out for use. Try the following:

1. Click the rollout labeled Parameters. The options below the Parameters rollout disappear.
Also notice that the minus (-) sign to the left of the rollout changes to a plus (+) sign. This
indicates that the rollout is in its closed state. The plus tells you that there is more infor-
mation inside, waiting to be rolled out.

2. Click the rollout labeled Name And Color. It also closes and displays a plus (+) sign to the
left. Click the rollout to open it again. Right-click a blank part of the interface within any
one of the rollouts, and you'll see a context menu (Figure 1.43). Select Close AlL

FIGURE 1.43 Close Rollout
Select Close All to Close All
close open rollouts Open All
in a panel
p v | Object Type
v | Name and Color
v | Parameters
v | Depth of Field Parameters
Reset Rollout Order

3. Notice that the Parameters and Depth Of Field Parameters rollouts closed but Object Type
and Name And Color remained open. This is because all objects on the Create Panel have
Object Type and Name And Color rollouts, and these always remain open by default. Any
additional rollouts belong to the object you have chosen to create and can be controlled
with this context menu. Try dragging the Depth Of Field Parameters rollout above the
Parameters rollout, as shown in Figure 1.44.
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FIGURE 1.44
Drag the Depth Of
Field Parameters
rollout above the
Parameters rollout

Object Type

4. You will see a horizontal blue bar appear with an image of the rollout you are dragging
ghosted. When you release the mouse, the rollout you are dragging gets docked where
the blue bar used to be. Now the Depth Of Field Parameters rollout should appear above
the Parameters rollout, as shown in Figure 1.45.

FIGURE 1.45

The new position of
the Depth Of Field
Parameters rollout

5. Click the Parameters and Depth Of Field Parameters rollouts again to display the options.

Now you can see how easy it is to control and customize the Command panel interface. In
this and later chapters, you'll explore the rollouts that appear in the Command panel.

CREATING OBJECTS AND SETTING THEIR PARAMETERS

By now, you've seen most of the 3ds Max interface and how it functions. However, you should
know about a few more tools and methods before you delve into using 3ds Max. In the follow-
ing exercises, you'll get a chance to create a simple object and, in the process, you'll be intro-
duced to a few new tools.

1. On the Create tab of the Command panel, click the Geometry tool at the top of the panel,
as shown in Figure 1.46. Make sure that Standard Primitives appears in the drop-down
menu, and you will see the Object Type rollout with a set of object types.

FIGURE 1.46 s AR 0o®E >
Click the Geometry
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types will appear.

Name and Color
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2.

FIGURE 1.47
The box object so

far

Click the Box button. Additional rollouts appear in the Command panel. They include
Creation Method, Keyboard Entry, and Parameters. Notice that a message in the
prompt line at the bottom of the screen says, “Click and drag to begin creation process.”
Also, the cursor in the graphic area displays as a cross, telling you that you're in Object
Creation mode.

In the Perspective viewport, place the cursor at the center of the graphic area at coordi-
nates 0,0, where the two darker grid lines intersect, and click and drag diagonally to the
upper-right corner of the screen — don't release the mouse button just yet. As you move
the mouse, a rectangle follows your cursor. Notice that the values in the Length and
Width input boxes in the Parameters rollout change as you move the mouse.

Place the cursor so that the rectangle looks similar to the one shown in Figure 1.47, and
then release the mouse button. (You don't need to match the rectangle in the figure
exactly.) Now, as you move the cursor, the rectangle changes in height. Notice that the
Height value in the Parameters rollout also follows the change in height.

Adjust the height so that the Height parameter shows about 3" 0, and left-click your
mouse. The box is now fixed at the height you selected. It should look similar to
Figure 1.48.

CREATE A NEW BOX IF NECESSARY

The following steps work as directed only if you have not deselected the box. If you have, click the
Undo Scene Operation button in the Quick Access Toolbar until the box disappears, create a new
box, and then proceed with the following steps.

You've just created your first object in 3ds Max and, in the process, you've seen how the
dimensions of an object are reflected in the Parameters rollout. Once you've created an object,
you can continue to modify its parameters, as the following exercise demonstrates.



FIGURE 1.48
The finished box

1.

FIGURE 1.49
Adjust the Width of
the box

2.

TOURING THE INTERFACE

In the Parameters rollout, locate the Width input box and click the up arrow to the right
of the box several times. Arrows like this one are called spinners, and they allow you

to adjust graphically the value of the associated input box. Notice that the box in the
Perspective viewport begins to widen as the value in the Width input box increases, as
shown in Figure 1.49.

Click and hold down the left mouse button while pointing to the up arrow of the Width
spinner. Notice that the box continues to grow in width as you hold down the mouse but-
ton. When you hold down the mouse button and move the mouse forward or backward,
the rate of change on the values accelerates.

Right-click the spinner arrow. The box shrinks in width to 0°0.0”. Right-clicking any spin-
ner changes the spinner value to its lowest possible non-negative value, which is 0°0.0” in
this case.

Click the Width spinner, and drag the mouse up. The box grows wider. Click and drag
down, and the width decreases.
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5. Click and drag the Width spinner up until your cursor reaches the top of the screen. Then
continue moving the mouse up the screen, and notice that the cursor reappears at the bot-
tom of the screen and continues moving up the screen. This circular action of the spinner
lets you scroll continuously without being limited by the screen area.

UNDOING SPINNER CHANGES

While adjusting a spinner, you can immediately undo any changes you make by right-clicking the
mouse while still holding the left mouse button. This allows you to experiment with spinner set-
tings quickly while you work.

You've just seen how you can change the parameters of an object by using the spinner. Now
let’s take a look at the absolute way of entering values into input boxes:

1. Double-click the Length input box in the Parameters rollout and type 60 . Notice how
the box’s length changes and the Length value changes to 50.0% the feet and inches
equivalent of 60”.

Notice that it’s not necessary to enter the inch (“) symbol to indicate a measurement in
inches. You are, however, required to enter the foot () symbol when entering a measure-
ment in feet. This is because you selected the Inches option as the default units in the
Units Setup dialog box earlier in the chapter.

2. Press the Tab key. Notice that the Width value is now highlighted, as shown in Figure 1.50.

FIGURE 1.50
Press the Tab key
to jump to the next
value

3. Type 60 for the width, and press Tab again. The Height value is highlighted.

4. This time enter 5" . The box is now a cube 60” square.

USING THE CUBE CREATION METHOD

You can also create a cube directly by selecting the Cube radio button in the Creation Method rollout.

USING THE TAB KEY

If there is a series of related input boxes — such as the Length, Width, and Height boxes in the pre-
vious exercise — the Tab key lets you advance from one field to the next. You’ll find that numeric
input boxes and spinners are quite common throughout 3ds Max.
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SETTING THE SPINNER RATE OF CHANGE

1f you hold down the Ctrl key while you move a spinner, the rate of change in the spinner value
increases. The Alt key has the opposite effect, decreasing the rate of change. The higher the numeric
value in the spinner, the faster the rate of change and vice versa.

Working with Objects

Now that you've seen the main elements of the 3ds Max interface, we’ll cover how you interact

with objects in the viewport. You'll start by looking at a way to move the box you've just created.

Then you'll learn how you can view your box from different angles.

Selecting and Moving Objects

The basic editing tools of 3ds Max are simple and straightforward, although it may take a little
explaining for you to grasp the finer points. As with most graphics programs, you use a selec-
tion tool to select objects. The Select tool is typically shown on the toolbar as an up arrow that
looks like the standard Windows cursor floating over a cube.

1.
2. Click a blank area of the viewport. This clears any selections that may currently be active.

3.

4.

FIGURE 1.51
The selected box

Click the Select Object tool in the Main Toolbar.

Move the cursor over the box. Notice that the cursor turns into a plus (+) sign. This tells
you that the cursor has found a selectable object.

Click the box to select it. A graphic displays, showing the X, Y, and Z orientation of the
box in relation to the viewport (see Figure 1.51). Also notice that in the Perspective view,
marks like 3D corner marks appear at the corners of the box. These are called selection
brackets, and they graphically indicate the objects that are selected.

With the box selected, you can go to the Modify tab of the Command panel and edit its prop-
erties, or you can use any number of other editing tools to affect the box.

Let’s continue by looking at one of the more basic editing tools you'll use — the Select And
Move tool.
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1. Click the Select And Move tool in the Main Toolbar. Notice that the graphics indicating
the box selection change and new ones appear.

2. Place the cursor on the box. It changes into the Select And Move icon.

3. Click the box if it isn't still selected. A manipulator known as the Move transform gizmo
appears, showing the X, Y, and Z orientation of the box in relation to the viewport.
Selection brackets also appear at the corners of the box.

4. Place the cursor on the blue Z-axis handle of the Move transform gizmo; the blue arrow
represents the Z-axis. Notice that the Z-axis and axis label highlight in yellow and the
X-axis and axis label turn back to red. When you move the cursor away from the Z-axis,
the X-axis is highlighted again and the Z-axis returns to blue.

The yellow highlighting shows you which axis is currently active. The X-axis is the
default constraint direction. If the Axis Constraints toolbar is still open, you'll see that the
X-axis button is selected. As you've seen in this step, you can select an axis to constrain
just by placing your cursor on the axis coordinate arrow.

5. Place the cursor on the XY-plane handle, the square that joins the X and Y handles of the
Move gizmo. Notice that the XY-plane handle highlights in yellow (see Figure 1.52). Click
and drag the box on the grid. The box now moves in the XY-plane. When you click and
drag the X arrow, movement is constrained along the X-axis only.

FIGURE 1.52
Moving the box in
the XY-plane

6. Click and drag the blue Z-axis handle upward. Now movement is constrained in the
Z-axis, away from and toward the grid. As you may guess, clicking and dragging the
green Y-axis handle constrains movement along the Y-axis.

THE LAST AX1S TRANSFORMED IS HIGHLIGHTED IN YELLOW

The axis that is highlighted in yellow is the last axis constraint that was used. For example, if you
transform an object in the Y direction, the next time you start to transform an object, the Y-axis
will be highlighted.
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If you click an object in a location other than the coordinate arrows, you can freely move the
object in the current axis or plane restriction. Notice that the coordinate location of the object is
displayed in the status line.

CONSTRAINING MOTION

The tools in the Axis Constraints toolbar constrain the motion of an object in the X-, Y-, or Z-axis. For
example, to constrain motion in the X-axis, click the Select And Move tool, and then click the X in
the Constraints toolbar. The selected object’s motion is constrained to the X-axis. In early versions
of 3ds Max, this was the only method available to constrain motion.

Another important function that the Axis Constraints toolbar offers is the selection of the default
free motion plane. In step 5 of the preceding exercise, you were able to move the box freely in the
XY-plane, but you were constrained to that plane. The Axis Constraints toolbar lets you select
the default plane to which you are constrained. The Restrict To XY-Plane tool is a flyout offering
three options: XY, YZ, and ZX. You can select the plane in which you want to constrain motion by
selecting one of these three options. The XY option is fine for nearly all of your work; every now and
then, though, you’ll want to use one of the other options, so it’s good to be aware of this tool. You
can also access these constraint planes simply by dragging the appropriate parts of the transform
gizmo — it’s very intuitive.

1f you prefer to use shortcut keys instead of a toolbar, the F5, F6, and F7 keys toggle the Y-, Y-, and
Z-axis constraints, respectively. Pressing the F8 key repeatedly cycles through the XY-, YZ-, and
XZ-plane constraints.

Finally, a tool that is related to the transform tools is the Selection Lock Toggle tool.

ak

Selection Lock Toggle

Any objects that are selected when this tool is clicked will remain selected as long as the Selection
Lock Toggle is toggled to the On position. This tool helps prevent the accidental loss of a selection
due to a mouse click. It also allows you to use the transform tools without actually placing the cur-
sor on the selected objects. You can also toggle this tool on and off by clicking it or by pressing the
spacebar while in a selection mode.

As you see, moving an object in 3ds Max is fairly straightforward. But what if you want to
move an object a specific distance or to a known position? The following exercise demonstrates
how this is done:

1. With the box still selected and the Select And Move tool still active, click the Absolute
Mode Transform Type-In button at the bottom of the 3ds Max window, as shown in
Figure 1.53. The tool changes to show that the Offset mode is active.

FIGURE 1.53
Absolute Mode
Transform Type-In
(top); Offset mode
(bottom)
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FIGURE 1.54
Moving the box to
the origin

When the Absolute/Offset Mode Transform Type-In button is in the Absolute mode (up),
you can enter the specific coordinates of the point where you want to move your object.
When it’s in the Offset mode (down), you can enter a relative distance from the object’s
current location.

Click in the X input box in the coordinate readout and type 10 . The box moves 10 inches
in the positive X direction.

Click and drag the Z-coordinate readout spinner upward. The box moves vertically.

. Click the Absolute/Offset Mode Transform Type-In button to switch to Absolute mode.

Then click in the Z-coordinate readout input box and enter 1" 1. The box moves so that its
base is exactly at 1" for the Z-coordinate.

Right-click the X-coordinate readout spinner. Remember that right-clicking a spinner con-
verts the value associated with the spinner to its lowest value, which is 0°0.0” in this case.
Notice that the box moves to 0 for the X-coordinate.

Right-click the spinners for the Y- and Z-coordinates in the coordinate readout. The box
moves to the center of the screen at the origin (coordinates 0,0,0), as shown in Figure 1.54.

Just as with the spinners in the Command panel, the Coordinate Display spinners let you
set values by clicking and dragging. You can also return to the default values of zero by right-
clicking the spinners. When in Offset mode, the spinners automatically reset to zero because the
values represent numerical values away from the current, baseline location. The spinners in the
coordinate readout appear when you turn on the Select And Move, Select And Rotate, or Select
And Scale tool from the Main Toolbar.
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ACCESSING THE TRANSFORM TYPE-IN DIALOG BOXES

If you are accustomed to earlier versions of 3ds Max, you can still use the floating Transform Type-In
dialog boxes that appear when you right-click the Select And Move, Select And Rotate, and Select
And Scale tools. Most recently, this functionality has been added to the quad menu; by clicking the
Settings button to the right of Move, Rotate, or Scale, you are taken to the appropriate Transform
Type-In dialog box automatically. You can also access the Transform Type-In dialog box by using
the F12 key.

Rotating and Scaling Objects

Besides the Move tool, the transform tools also include the Rotate and Scale tools. Try the fol-
lowing set of exercises to see how these tools work.

1. With the box selected, click the Select And Rotate tool in the Main Toolbar. The Rotate
transform gizmo, a kind of virtual trackball, appears with rings representing the rotation
about the X-, Y-, and Z-axes.

2. Place your cursor on the red ring that circumscribes the X-axis. Notice that the ring is
highlighted in yellow. Click and drag the X-axis ring upward. The box rotates about the
X-axis, as shown in Figure 1.55. A tangent indicator arrow will appear, indicating the
direction of rotation. A transparent red slice along with a text tooltip also appears, dis-
playing the amount of rotation. Release the mouse button to set the rotation angle.

FIGURE 1.55
Rotating the box
about the X-axis

Make sure that the Absolute/Offset Mode Transform Type-In button is in the Absolute
mode and look at the coordinate readout. Notice that the X value is not zero, because you
rotated it in step 2. It now shows a number of degrees.

3. Right-click the X spinner in the coordinate readout to set the X value rotation back to
zero. Notice that the box snaps back to its original orientation.
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The Select And Rotate tool’s methods are the same as the Select And Move tool’s methods.
You can rotate an object graphically by clicking and dragging the object or, with an object
selected, you can enter an exact rotation value in the coordinate readout. When the Absolute/
Offset Mode Transform Type-In button is in the Absolute mode, you can control the orientation
in relation to the object’s original orientation when it was created. In the Offset mode, you can
control the orientation relative to the object’s current orientation.

Now try the Select And Uniform Scale tool:

1. With the box selected, click the Select And Uniform Scale tool in the Main Toolbar. The
ﬁ Scale transform gizmo appears, showing the X, Y, and Z orientation of the box in relation
d to the viewport.

2. Click in the center of the Scale gizmo that appears, or on the box itself, and drag upward.
The box grows uniformly in size.

3. Click and hold the Select And Uniform Scale tool. Then, from the flyout, select the middle
tool, which is the Select And Non-uniform Scale tool, as shown in Figure 1.56. This step is
not absolutely required; it is presented here to clarify the concept. The axis handles alone
can be used to scale an object non-uniformly.

FIGURE 1.56 Modifiers  Animation  Graph Editor,
The Select And “E‘ ) 7 ;.}
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4. Drag the XY-plane handle of the Scale gizmo (highlighted in yellow onscreen) to scale the
box non-uniformly in the XY-plane in this case, but not along the Z-axis. Similarly, the
axis handles can be dragged individually to constrain the scaling of an object to one axis
(Figure 1.57).

FIGURE 1.57
Using the
Non-uniform Scale
transform on the
box




WORKING WITH OBJECTS ‘ 33

Now take a look at the coordinate readout. The values you see are percentages of scale. When
the Absolute/Offset Mode Transform Type-In button is in the Absolute position (up), the values
are percentages of the original size of the object. When it’s in the Offset position (down), the
values are the scale in relation to the current size and are immediately reset to 100 percent when
you release the mouse button.

1. With the Absolute/Offset Mode Transform Type-In tool in the Absolute position, click
and drag the Z spinner up. Notice that the box grows in the Z-axis.

2. Right-click the Y-axis spinner. The box distorts to a 0 value in the Y-axis.

3. Click in the X-value input box, and enter 100 .!. The box’s X value is restored to its origi-
nal size.

How 3DS MAX SEES THE SCALE TRANSFORM

Lookat the box’s Length, Width, and Height values in the Parameters rollout in the Command panel.
1f the Parameters rollout for Boxo01 does not display, you have to click the Modify tab. The values
all read 5°0.0” even though the box has been scaled. This is an important indicator as to how 3ds
Max handles object data. For example, if you have a box that is 1 unit long on each side and then you
scale it to twice its size, 3ds Max does not now see this as a box that is 2 units on each side; it sees
it as a 1-unit box with a 200 percent scale factor applied.

4. Press the Tab key to move to the Y-value input box and enter 100 .

5. Press Tab again to move to the Z-value box and enter 75 .. The box is now slightly shorter
than it is wide and long.

The Select And Scale tool works in a slightly different way from the other two transform
tools. For one thing, a zero value in the coordinate readout doesn’t return the selected object to
its original shape. This is because the values in the coordinate readout represent percentages,
where 100 percent is the object’s original size.

The Scale gizmo allows you both to uniformly and non-uniformly scale an object by auto-
matically switching between scale modes. Which operation you perform depends on which part
of the Scale gizmo you drag.

1. Try dragging the center of the Scale gizmo. You will see the object get uniformly bigger
or smaller when you drag upward or downward.

2. This time, put your cursor over one of the edges of the Scale gizmo. When you drag over
one of the plane handles, you are performing a non-uniform scale in two directions at
once. Look closely at the gizmo, and you can see that the two axes of the plane are high-
lighted. Try non-uniformly scaling the box in the YZ plane (see Figure 1.58a).

3. The last operation you can perform using the Scale transform gizmo is a non-uniform
scale in one direction. To accomplish this, put your mouse directly over the axis handle
at the tip of an axis. For example, put your mouse over the end of the Y-axis and drag to
scale in that direction only, as shown in Figure 1.58b.

Once you master the mechanics of the transform gizmos, you will find that you have much
finer and more intuitive control over your objects in 3ds Max.
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FIGURE 1.58
Using the Uniform
Scale transform
gizmo, in two axes
on the box (a), and
along one axis, on
the box (b)

Copying an Object

We’ve covered just about all the ways of moving, rotating, and scaling an object in the
Perspective viewport. If you want to copy an object, use the same methods you would to move,
rotate, or scale objects — with the addition of holding down the Shift key. Try the following
steps to see how copying, or cloning, as it’s called in 3ds Max, works. (Copying is one of the
forms of a more general function called cloning.)

1.

FIGURE 1.59
The Clone Options
dialog box

6.
7.

From the Application menu, choose Open and click No in the dialog box that opens ask-
ing whether you want to save the changes in your current file. The Open File dialog box
appears. Navigate to the Chapter 1 files you downloaded from the book’s accompanying
web page, www. sybex.com/go/mastering3dsmax2013. Select the Chair.max file, and then
click the Open button.

Click the Select Object button in the Main toolbar, and then select the chair.
Click the Select And Move button.

While holding down the Shift key, move the cursor over the XY-plane of the transform
gizmo, and then drag the chair to the left. A second chair appears.

Release the mouse button. The Clone Options dialog box displays (see Figure 1.59). This
dialog box lets you control the quantity and type of copies you're making as well as the
name of the new objects.

In the Object group of the Clone Options dialog box, select Copy.
Click OK. The new chair is added to your model, as shown in Figure 1.60.
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CREATE A COPY IN THE SAME LOCATION AS THE ORIGINAL

You may want to make a copy of an object in exactly the same location as the original object. To
accomplish this, first select the object you want to copy and then select Edit > Clone from the
Menu Bar or press Ctrl+V on the keyboard. You will see a Clone Options dialog box similar to the
one that you saw in the preceding exercise. Set your options and click OK. Note that the new copy
doesn’t appear at first because it occupies the same space as the original. (You can accomplish the
same thing by Shift+clicking an object with the Select And Move tool or by selecting Clone from the
Transform quad menu, which can be accessed by right-clicking the object.)

FIGURE 1.60
The original and
cloned chairs

In step 6, you selected the Copy option in the Clone Options dialog box. This option creates a
distinct copy of the original object. The other two options, Instance and Reference, create clones
that are related to the original in such a way that changes in one object affect the other. You'll
learn more about these options in Chapter 2, “Introducing Objects.”

PARKING CURBS AND BOLLARDS

Jon McFarland, one of the authors of this book’s 2010 edition and the technical editor on this edi-
tion, says that every project has features in it that vary from interesting and cool to mundane and
repetitive. Although we all like to work on the exciting projects, we all do our share of the latter.
When those less-than-exciting projects pop up, it’s best to crank them out quickly and accurately
and then move on to the next portfolio-quality project down the line.

While the main effort of McFarland’s company was focused on the creation of a mall, complete
with an entertainment center and several freestanding buildings for restaurants and other shops,
someone had to work on the parking lot. He was hired to place several thousand parking curbs and
bollards (vertical posts used to restrict vehicular traffic) accurately throughout the parking lot
and around the entrances to the structure. Parking curbs are usually identical and placed equidis-
tant from each other (usually 9" 0" apart), so the layout wasn’t difficult. After modeling the simple
curb, he placed one at the end of each parallel run of parking spaces. He selected the first curb on
each run, held down the Shift key, and moved it 9" in the proper direction. In the Clone Options
dialog box, he set Number Of Copies to the number of curbs in the longest run and then deleted
any superfluous curbs.
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This process was repeated several times for the remaining curbs, and then a similar process was
used to place the bollards. Upon receiving the completed work, the company assigned McFarland
the task of creating the traffic islands and the screen walls around the service areas. He says, “I'm
sure one of these days they’ll give me a fun job to do.”

Selecting Multiple Objects

You've now learned how to select, move, and copy a single object, but what do you do if you
want to move or copy several objects at once? You can select multiple objects, or create selection
sets, as they are called in 3ds Max, using two methods. The first is one that is also employed in
other graphics programs.

1. Click the Select Object tool on the Main Toolbar.

2. Click a blank area of the viewport to clear any selections you may already have, or press
Ctrl+D on the keyboard.

3. Click and hold your cursor at a point below and to the left of the chair copy. Then drag
upward to the right. Notice that a dotted rectangle follows your cursor, as shown in
Figure 1.61.

FIGURE 1.61 ...to here.
Placing the selec-
tion rectangle

around the chairs

Click and drag from here...

4. Continue to drag the cursor upward and to the right until it encloses both chairs. Then
release the mouse button. Both chairs are selected.

Notice that selection brackets (or bounding boxes) appear at the corners of both chairs, and a
gizmo appears between them, indicating that the two objects are selected. You can select objects
in a couple of other ways, which you'll learn about in a moment, but first, let’s use the current
selection to make a few more copies of the box.

1. Click the Select And Move tool in the Main Toolbar.



WORKING WITH OBJECTS

2. Hold down the Shift key, and drag back the X-axis arrow of the Move transform gizmo so
that copies of the two chairs appear in the location shown in Figure 1.62. (You don’t need
to be exact about the placement of the copies.)

3. When the copies are in place, release the mouse button.

4. In the Clone Options dialog box, make sure that Copy is selected in the Object group and
click OK.

FIGURE 1.62

Place the copies just
beyond your first
two objects.

The four chairs will help to demonstrate some of the other selection methods available to
you. First, let’s look at another property of the selection windowr:

1. Click the Select Object tool, or right-click and choose Select from the quad menu.
2. Click a blank spot in the viewport to clear your selection set.
3. Click and drag the cursor from the point indicated in Figure 1.63.

FIGURE 1.63

Selecting points for
a crossing window

Click and drag from here... ...to here.

37



38 |CHAPTER 1 GETTINGTOKNOW AUTODESK®3DSMAX®2013

4. Drag the rectangle up and to the right so that it completely encompasses one chair but
just a portion of two other chairs, as shown in Figure 1.63. Then release the mouse button.
Three of the four chairs are selected.

Notice that you didn’t need to enclose the chairs completely to select them. In the current
selection mode, you only need to have the selection window cross over the desired objects. This
is known as a crossing window. If you're an AutoCAD user, this type of window should be famil-

iar to you.
CERT You can change the way the selection window works by using the Window/Crossing
OBJECTIVE . . . .
Selection tool. The following exercise demonstrates this:
1. Click a blank area in the drawing in order to clear your selection set.
2. Click the Window/Crossing tool in the Main Toolbar.

Notice that the icon highlights in blue and changes to one showing a cube that’s com-
pletely within a dotted rectangle. This tells you that you are now in Window Selection
mode.

3. Click a point above and to the left of the front left chair in the foreground, as shown in
Figure 1.64.

FIGURE 1.64 Click and drag from here...
Placing a Window
Selection window

...to here.

4. Drag the rectangle downward and to the right until it completely encompasses the two
chairs in the front, as shown in Figure 1.64. Then release the mouse button. Notice that
the only objects selected are the two chairs on the left.

When you use Window Selection mode, only objects that are completely within the selection
window are supposed to be selected. Unlike with the Crossing Selection window, objects that
are partially inside the selected window are supposed to be omitted from the selection. There
is an issue with 3ds Max 2013 with the updated Nitrous viewports that cause some objects to be
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selected if their pivot point is within the Window Selection window, even if the entire object is
not enclosed in the selection.

You can use the Ctrl key in conjunction with any selection method to continue to add more
objects to your selection set. You can also remove objects from your selection set by using the
Alt key. This was a new behavior introduced in 3ds Max 2011. Previously the Ctrl key would
both add to and subtract from selection sets. Now the Ctrl key is only for addition and the Alt
key only for subtraction. The following activity demonstrates how adding and subtracting from
selections works:

1. Switch back to the Crossing Selection method, and then Ctrl+click and hold a point below
and to the right of the chair near the bottom of the viewport. Notice the small plus (+)
sign next to the cursor indicating that selected objects are to be added to the current
selection set, as shown in Figure 1.65.

FIGURE 1.65

Adding objects to
your selection set
using the Ctrl key

2. Drag the window upward and to the left so that it encloses a portion of the two chairs on
the right. Then release the mouse button. Now all four chairs are selected.

3. Hold down the Alt key and then click (Alt+click) the chair in the upper right of the
screen, as shown in Figure 1.66. Now all chairs except the upper-right one are selected.

FIGURE 1.66
Removing an object
from your selection
using the Alt key
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You can change the shape of your selection window to help select objects. There are
Rectangular, Circular, Fence, Lasso, and Paint Selection Region options. The next exercise
explores the lasso selection region, which allows freeform sketching for a selection.

1. Click and hold to open the Selection Window flyout, and click the Lasso Selection Region
button.

2. Switch back to the Window Selection option.

3. Sketch alasso selection region by dragging the mouse in a freeform manner around two
of the chairs to select them, as shown in Figure 1.67. Because the Ctrl button was not held
down during the selection process, only the two chairs fully encompassed by the lasso
are selected while the rear-left chair, which was previously selected, is now unselected.

FIGURE 1.67
Selecting objects
using a lasso selec-
tionregion

Right now, you have only a few objects in your model, but as your models and scenes
develop, you'll find that selecting objects in a crowded model becomes more of a challenge.
Knowing about the different selection modes will go a long way toward making your work
easier.

One more selection method will be an invaluable tool as your model becomes more complex.
You can select objects by their names, using the Select From Scene dialog box. The following is a
quick exercise that will introduce you to this important tool.

1. Click the Select By Name tool in the Main Toolbar or press H on the keyboard.

The Select From Scene dialog box displays. It contains a list showing the names of the
objects in your drawing with the currently selected objects highlighted (see Figure 1.68).
Groups of objects are preceded by an icon consisting of an overlapping circle and square
contained within brackets. Right now, the list shows the default names given to the
objects by 3ds Max. You can always change the name of an object in the Command panel.
(You can rename an object on every tab except Utilities.)

2. Click the Select None button on the second row of icons on the dialog box. This clears the
selection.

3. Click MeshChair001 and then Ctrl+click MeshChair003 in the list of object names. This
list lets you select multiple names as you would in a typical Windows list box. You can
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Shift+click to select a group of adjacent names or Ctrl+click to select a group of individual
names. Figure 1.69 shows the Select From Scene dialog box with the new selection.

FIGURE 1.68
Selected objects Select Display Customize
appear highlighted
in the Select From
Scene dialog box.

FIGURE 1.69
The Select From Select Display Customize
Scene dialog box
with the new
selection set

4. Click the OK button. The two chairs are selected.

The preceding exercise showed you how to select objects based on their names, but it also
indirectly showed you the importance of the names of objects. Giving objects meaningful names
helps you locate and select them more easily, especially in a crowded model.

EACH OBJECT HAS ITS OWN NAME AND PARAMETERS

3ds Max is a parametric, object-oriented program, and every object has its own name. Each object
has its own parameters that can be accessed from the Modify tab.

Whenever you create an object in 3ds Max 2013, you have the opportunity to give the new
object a name. If you don't indicate a new name, 3ds Max provides a name for you. If the new
object is a copy of an existing one, the new name that 3ds Max provides is the name of the origi-
nal object, with a number appended to its name. If you don't give an object a meaningful name
when you create it, it’s easy enough to change the name later. Just select the object, and then
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enter a new name in the Object Name input box at the top of the Modify tab or in the Name And
Color rollout of the Create tab.

Naming Selection Sets

Suppose you've gone through a lot of effort selecting a set of objects, and you know you will
want to select the same set of objects again at a later time. 3ds Max offers the Named Selection
Sets tool, which lets you name a selection set for later recall. Here’s how it works:

1. Make sure two of the chairs are selected. It doesn’t matter which two, because you're just
practicing using the Named Selection Sets tool.

2. Click inside the Named Selection Set input box that’s just to the left of the Mirror tool in
the Main Toolbar.

3. Type the name Sample ., as shown in Figure 1.70. You've just given the current selection
set a name. (You can enter a selection set name up to 15 characters long.)

FIGURE 1.70

Enter Sample in the :E'/ FH
Named Selection —
Sets field

4. Click in a blank area of the viewport to clear the current selection set.

5. In the Main Toolbar, click the down arrow to the right of the Named Selection Sets input
box. Select Sample. The two chairs you selected earlier are now the current selection set.

In these early stages of learning 3ds Max, the concept of named selection sets may seem
unnecessary, but you'll likely use named selections quite a bit as you expand your skills.

OTHER METHODS FOR SELECTING OBJECTS

The Edit option in the Menu Bar offers some additional selection commands, such as Select All,
Select None, and Select Invert. You can also use the Edit > Select By cascading menu to select
objects by color, name, or layer.

Editing Named Selection Sets

Named selection sets are not set in stone. You can add to or subtract from them, or you can
delete them entirely through the Named Selection Sets dialog box.

1. Open the Named Selection Sets dialog box by choosing Edit > Manage Selection Sets or
by clicking the Edit Named Selection Sets button just to the left of the Named Selection
Sets input box you used before (Figure 1.71). The Named Selection Sets dialog box
appears with a list of all of the selection sets that have been created.

FIGURE 1.71
Edit Named

Selection Sets Edit Named Selection Sets
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2. Click the plus (+) symbol next to your Sample named selection set to see which objects are
contained within this set, as shown in Figure 1.72.

FIGURE 1.72

The Named
Selection Sets
dialog box showing
the contents of the
Sample selection
set

3. Click Sample in the list. Then click the Select Objects By Name button in the Named
Selection Sets toolbar (Figure 1.73).

FIGURE 1.73
Select Objects By
Name

4. The Select Objects dialog box displays — this is identical to the Select From Scene dialog
box that you used in the previous exercise. Select one of the names in the list that doesn’t
already appear in the Named Selection Sets dialog box, as shown in Figure 1.74, and then
click the Select button. This selects the listed objects in the scene but doesn’t add them to
the named selection set.

FIGURE 1.74
Selecting an object
with the Select
Objects dialog box

Select Display Customize
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SEVERAL OBJECTS ACTING AS ONE

It may appear that objects in the Select Objects or Select From Scene dialog box are different from
the objects listed in the Named Selection Sets dialog box. This is only partially correct. The chairs
used in these exercises are groups, collections of objects that react as if they were a single object. The
Select Objects and Select From Scene dialog boxes display the names of the groups, but the Named
Selection Sets dialog box displays the names of the component objects that make up the groups.
Groups are covered in more detail in the “Working with Groups” section in Chapter 2.

5. Click the Add Selected Objects button in the Named Selection Sets dialog box
(Figure 1.75).

FIGURE 1.75
Add Selected
Objects

The names of the objects you selected now appear in the list of objects contained in the
selection set, as shown in Figure 1.76.

6. Close the dialog box, and deselect all by clicking off to the side in the viewport.

7. Select Sample from the Named Selection Sets drop-down list. Now you see that three of
the chairs are selected.

8. Click a blank area of the viewport to clear the selection set again.

FIGURE 1.76
The expanded list
of objects in the
Named Selection
Sets dialog box
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There are several other tools in the Named Selection Sets dialog box. These tools let you
select objects from a set, highlight selected objects, delete objects from a set, or remove a set alto-
gether. You can also create new named selection sets using the Create New Set tool at the far left
of the toolbar on the Named Selection Sets dialog box.

You've now seen most of the selection tools you'll need to get started with 3ds Max. You'll
learn about a few other selection tools as you work with 3ds Max, and you'll also get a chance to
apply the tools you've already learned as you start to build and edit 3D models in later chapters.

In the next section, you'll learn about the tools that enable you to view your model from dif-
ferent angles and how these different views can aid you in creating and editing your model.

Named selection sets can also contain selections of sub-objects, such as vertices, edges, or
polygons, the components that make up an object. When a sub-object named selection set is cre-
ated, it is available only when that object is selected and the sub-object level is accessed. You will
learn about sub-objects in Chapter 4.

Getting the View You Want

So far in this chapter, you've done all of your work without making any modifications to
the point of view of your model. Now let’s take a look at ways you can control your view.
Understanding the viewport controls is essential for manipulating objects in your model, so
take some time to become familiar with all the tools discussed in this section.

Understanding the Perspective Viewing Tools

If you look at the viewport navigation controls in the lower-right corner of the 3ds Max window,
you’'ll see some tools that are common among most graphics programs. They include the magni-
fying glass and the hand. Other tools in this area may be a bit more mysterious. In this section,
you'll learn how these tools let you get around in your model.

PANNING AND ZOOMING YOUR VIEW

Let’s begin by looking at the tool with the hand icon, known as the Pan View tool. Like similar
tools in other programs, the Pan View tool displaces your view up, down, left, or right. But in
the 3ds Max Perspective viewport, it also changes your point of view. Do the following to see
what this means:

1. Click the Pan View tool.

2. Click and drag the cursor to the left and upward until the chairs are roughly centered in
the viewport.

3. In the viewport, click and drag the cursor in a circular fashion. Notice that your view of
the model appears to change as if you were moving sideways while looking at the chairs.

Next try the Zoom tool:
1. Click the Zoom tool.

2. Click and drag the cursor up from the center of the viewport. Notice how you appear to
get closer to the chairs.

3. Click and drag the cursor down in the viewport. Now you appear to be moving away
from the chairs.

45
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4. Continue to click and drag downward until your view looks similar to the one shown in
Figure 1.77.

FIGURE 1.77
Zooming out to
view a larger area

Depending on your settings, as you moved farther away, the grid may have become denser.
Then, at a certain point, the grid changed to a wider interval. 3ds Max does this so that the grid
doesn’t overwhelm the view when it becomes too dense.

If the grid does not increase in size to fill the viewport, right-click the Snaps toggle in the
Main Toolbar. Click the Home Grid tab in the Grid And Snap Settings dialog box, and uncheck
the Inhibit Perspective View Grid Resize option.

Again, as with other graphics programs, the Zoom tool enlarges or reduces your view. In
addition to the Zoom tool, you can use the wheel of the mouse to zoom in and out within a
viewport. In the 3ds Max Perspective viewport, zooming has the effect of moving you closer to
or farther away from the objects in your model.

Now suppose you don't like the last view change you made and you want to go back to the
previous view. Try the following steps to return to the previous view:

1. Choose Views > Undo View Change. You return to the previous view. (Alternatively,
press Shift+Z.)

2. Choose Views > Undo View Change or press Shift+Z again. Your view returns to the
view prior to the last view.

3. Choose Views > Undo View Change a third time. You return to the view you had before
you panned your view.

The Views > Undo View Change command lets you step back to a previous view in case the
last view change you made is one you don't like. Views > Undo View Change undoes any view
change, regardless of which viewport tool you used last.

UNDO VIEW IS DIFFERENT FROM UNDO

Don’t confuse Views > Undo View Change with the Edit > Undo command. Edit > Undo undoes
creation and editing operations but not view changes.
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SAVING A VIEW You LIKE

If you happen to get a view that you know you want to go back to later, you can save the view
with the Views > Save Active View command from the Menu Bar. Use it in the next exercise
to save a view that you'll return to later in this chapter. As you'll see in Chapter 7, “Light and
Shadow,” you can also create a Camera object and align it to an existing view.

1. Click the Zoom Extents tool to set up your view for the next exercise. Zoom Extents
causes the viewport to display the entire model.

2. Save this view by choosing Views > Save Active Perspective View.

The Zoom Extents tool repositions your view so that the entire model just fits within the
viewport, filling the viewport as much as possible. If youre an AutoCAD user, you're familiar
with this tool, because its counterpart in AutoCAD performs the same function.

RESETTING THE PERSPECTIVE VIEWPORT

You can also restore the Perspective viewport (the one you see in the lower-right corner when you
open a new file) in a blank file by clicking the Zoom Extents tool.

CHANGING YOUR VIEWING ANGLE

Three other tools are specifically designed for viewing 3D objects: Field-Of-View, Orbit Selected,
and the ViewCube® tool. The Field-Of-View tool changes your field of view, the Orbit Selected
tool lets you rotate your view around a selected object, and the ViewCube contains several tools
for modifying your viewpoint.

The Field-Of-View tool appears to do the same thing as the Zoom tool but, as you'll see in the
following exercise, there is a significant difference between the Zoom and Field-Of-View tools.

1. Save the current view by choosing Views > Save Active Perspective View. This lets you
return to the current view later.

2. Click the Field-Of-View tool.

3. Place the cursor in the viewport, and click and drag downward until your view looks
similar to Figure 1.78.

FIGURE 1.78

The Perspective
viewport after
increasing the field
of view
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In one sense, it appears as though you've zoomed out from the chairs, but if you compare this
view to the zoomed-out view in the previous exercise, you'll notice a difference. When you use
the Zoom tool in the Perspective viewport, your view changes as though you were physically
moving closer to or farther away from the chairs. As the name implies, the Field-Of-View tool
widens or narrows your field of view in the same manner as a zoom lens on a camera. You're
not actually changing the distance from the object; instead, youre changing the area that your
viewport displays. The Field-Of-View tool has the potential to distort your view, just as a super-
wide-angle fish-eye lens or a super-telephoto lens tends to distort a photograph. Until you are
in a situation where you really need to change the field of view, you may want to refrain from
using the Field-Of-View tool.

Now let’s take a look at the Orbit Selected tool:

1. Return to the view you had before you used the Field-Of-View tool by choosing Views >
Restore Active Perspective View.

2. Click the Select Object tool, and then click a blank space in the viewport to clear any
selections that may be active. In the next exercise, you'll see why this is significant.

3. Click the Orbit Selected tool (this may be hidden on the Orbit flyout menu).

You see a yellow circle with squares at each of the four cardinal points on the circle. If
you place your cursor inside the circle, the cursor looks like two overlapping ellipses, as
shown in Figure 1.79.

4. Place your cursor on the square at the far left of the circle. Notice that the cursor changes
shape to what looks like a horizontal ellipse.

FIGURE 1.79

The Orbit Selected
tool used in the
Perspective
viewport

5. With your cursor on the square, slowly click and drag the cursor to the right. Notice how
the view rotates.

6. Place your cursor on the square at the top of the circle. Now the cursor changes to a verti-
cally oriented ellipse.
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7. With your cursor on the square, click and drag the cursor down. The view now rotates in
that direction.

The squares on the yellow circle are like handles that you can grab and turn to change your
view orientation. The left and right squares constrain the rotation to the horizontal plane, and
the top and bottom squares constrain the rotation to the vertical plane. If you prefer, you can
adjust the view freely without constraint in the vertical or horizontal direction by clicking and
dragging the cursor anywhere within the circle. You can also rotate the view by clicking and
dragging anywhere outside the circle. The following exercise demonstrates these features. Pay
attention to the shape of the cursor in each step.

1. Place your cursor anywhere within the circle. Then slowly click and drag in a small, cir-
cular motion. Notice how the view changes as if your point of view were rotating around
the group of chairs.

2. Place your cursor anywhere outside the circle. Then slowly click and drag in an up-and-
down motion. Now the view rotates around the circle as if you were tilting your head
from side to side.

You may have noticed that the cursor changes, depending on whether you're inside or out-
side the circle. This gives you further cues regarding the way the Orbit Selected tool affects
your view.

You've been introduced to nearly all of the viewport tools. However, there’s one more feature
of the Orbit Selected tool that you'll want to know about before you continue. The Orbit Selected
tool uses the center of the viewport as the center about which it rotates when no object is
selected. But the Orbit Selected tool works in a slightly different way when objects are selected.
Try the following exercise to see how this variation works:

1. Choose Views > Restore Active Perspective View to restore the view you saved earlier.
2. Click the Select Object tool from the Main Toolbar.

3. Click the chair on the left side in the back row, as shown in Figure 1.80.

FIGURE 1.80
Selecting a chair in
the back row
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o 4. Click the Orbit Selected tool again.

5. Slowly click and drag the cursor within the circle. Notice how the view appears to be
fixed at the center of the selected chair.

6. Slowly click and drag the cursor in a vertical motion outside the circle. The view appears
to rotate around the selected chair.

7. Return to the saved view by choosing Views > Restore Active Perspective View.

If you click and hold the Orbit Selected tool, you'll see two other Orbit tools in the Orbit
flyout. The tool at the top, called simply the Orbit tool, rotates the view about the view center,
regardless of whether an object is selected. You've already seen how the second tool, the Orbit
Selected tool, works. The tool at the bottom of the Orbit flyout is the Orbit SubObject tool. This
tool rotates a view about a sub-object-level selection. You'll learn about sub-object-level editing
in Chapter 4.

ORBIT ON THE FLY

You can orbit on the fly, without leaving the current command, by holding down the Alt key on the
keyboard and holding down the wheel button while you move the mouse. This is a huge time-saver
because you’ll find that you don’t have to spend time clicking the Orbit button when you want to
rotate your viewing angle.

UsING THE VIEWCUBE

Changing the viewpoint to view your scenes is especially important in a 3D environment
because you are more likely to encounter a situation where foreground objects obscure back-
ground objects. The ViewCube, the tool in the upper-right corner of the viewport, is used to
access common views quickly, return to a saved view, or navigate freely in the drawing area.
The ViewCube consists of a center cube with each face labeled, identifying the standard

CERT
OBJECTIVE orthographic view that it represents. Clicking any of these labeled faces changes the view-

point in the drawing area to display the objects from that point of view. For example, clicking
the ViewCube face labeled TOP changes the drawing area to display the scene from the top,
with the X-axis pointing to the right and the Y-axis pointing to the top of your screen (see
Figure 1.81).

FIGURE 1.81 Click to switch to the Home view.
The functions of the Click a face to switch to that view.
ViewCube

Click a corner to
switch to an

Click an edge to isometric view.

switch to a view
rotated 45° from
the adjacent

Click a letter to switch
to an elevation view

Click and drag to seta from that direction.

non-standard view.
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The face views are not the only viewpoints that you can access from the ViewCube. Clicking
any corner changes the drawing area to display the objects from an isometric vantage point that
is a combination of the three labeled faces. Clicking the corner at the intersection of the TOP,
FRONT, and LEFT faces (see Figure 1.82a) produces a southwest isometric view.

FIGURE 1.82
Clicking a corner of
the ViewCube cre-
ates an isometric
view (a), and click-
ing an edge of the
ViewCube creates
aview adjacenttoa
face view (b).

Clicking any of the edges (see Figure 1.82b) changes the drawing area to display the objects
rotated 45 degrees from one of the adjacent face views. You'll usually perform a Zoom after
using the ViewCube.

Surrounding the ViewCube is a ring with the compass directions indicated. Clicking any
of the letters switches the view in the drawing area to a view from that direction. For example,
clicking the letter E on the ring displays the elevation from the east.

Switching to a predesignated view is quick and can often provide the vantage point that you
need, but you may have to view your objects from a specific, nonstandard location. Clicking and
dragging the ViewCube changes the viewpoint freely without any constraints to the predesig-
nated views.

Another tool, called the SteeringWheels® tool, lets you zoom, pan, and orbit in the viewport
similarly to these other methods. Because this tool is off by default, were not going to cover it in
this book. The SteeringWheels tool is available in other Autodesk programs; if you are familiar
with it and want to use it, you can turn it on by choosing Views > SteeringWheels > Toggle
SteeringWheels.

By being able to select an object or set of objects as the center of rotation for your view, you
are better able to set up your views for rendering or editing. The combination of the Zoom, Pan,
and Orbit tools allows you to obtain just about any view you may need as you work within the
3ds Max Perspective viewport. But you aren’t limited to a perspective view of your model. In
fact, there are many situations where the perspective view is not ideal, especially when editing
your model. In the next section, you'll look at other viewport types that give you greater flexibil-
ity in creating and editing objects in your model.

Using Multiple Viewports

So far, you've done all your work in the Perspective viewport, but this isn't the only view you
have available. You currently have four equal viewports, each representing a different view.
Let’s explore some 3ds Max display tools in the other viewports, starting with the way that the
Field-Of-View tool changes when your active viewport changes.

1. If necessary, click the Maximize Viewport toggle in the set of viewport navigation con-
trols to display a four-viewport configuration.

2. Click anywhere in the viewport labeled Top in the upper-left corner of the display. Notice
that the Field-Of-View tool changes to a magnifying glass with a rectangle. This is the
Zoom Region tool.
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Also notice that the Top viewport now shows a gold border around it, indicating that it is
the active viewport.

E 3. Click the Zoom Region tool.

4. Click and drag the cursor on a point above and to the left of the chairs, as shown in
Figure 1.83. As you drag the cursor, you see a rectangle appear. Don’t release the cursor
yet.

FIGURE 1.83
Selecting a view to
enlarge with the
Zoom Region tool

5. Position the rectangle below and to the right of the bottom row of chairs, as shown in
Figure 1.83, and then release the mouse button. The view enlarges to the region you just
indicated with the Zoom Region tool.

The Zoom Region tool acts like the magnifying tools in many other graphics programs. Also,
the Zoom and Pan View tools perform the same functions in orthogonal views in 3ds Max as
they do in other programs, allowing you to zoom in and pan over the view. The Zoom Region
tool is available in Perspective viewports. It is in the flyout under the Field-Of-View tool.

You may have noticed two other tools in the viewport navigation controls that haven’t been
discussed yet: the Zoom All and Zoom Extents All tools. Now that you have multiple viewports
displayed, you can try these two tools:

E 1. Click the Zoom All tool.

2. Inany viewport, click and drag the cursor up and down. Notice that the view in all of the
viewports is enlarged or reduced as the cursor moves.

3. Click and drag the cursor down, and the views expand to show more of the model area.

4. Click the Zoom Extents All tool.
wh

All of the viewports change to display enlarged views of the chairs, as shown in
Figure 1.84.
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FIGURE 1.84

The four viewports
after using the
Zoom Extents All
tool

Although not as frequently used as the other viewport navigation tools, the Zoom All tool
and the Zoom Extents All tool can be helpful when you need to adjust the overall view of your
model in multiple viewports.

You should be aware that the Orbit Selected tool you used in the Perspective viewport also
works in the other viewports. Try it out on the Top viewport in this exercise:

1. Click the Orbit Selected tool.

2. Select one chair, and then click and drag the cursor from the center of the Top viewport
upward and to the right, so that it shows a view similar to Figure 1.85.

FIGURE 1.85 E+ 1[Ovthagraphic ] [Shaded ]
The Top viewport
after using Orbit
Selected

The view changes to a type of 3D view known as an orthographic projection. Also notice
that the label in the upper-left corner of the viewport now reads Orthographic. This indi-
cates that the view is a custom view based on your changes.

3. Click the Zoom Extents tool to center the view in the viewport.
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The 3D view in the upper-left corner of the display differs in many ways from the perspec-
tive view. But, as you'll see in the next section, it’s different only because a few of the settings for
that viewport are different from those of the Perspective viewport.

Changing the Viewport Display and Configuration
If you compare the Orthographic viewport with the Perspective viewport, you'll notice one
thing that is different. As mentioned in the previous exercise, the Orthographic viewport shows
a 3D orthographic projection. Parallel lines do not converge as the distance from the viewpoint
increases as they do in the Perspective viewport. You'll notice that the Orthographic viewport
is set to the Shaded display mode. The chairs appear solid, they have color and texture, and the
metal appears shiny. These display characteristics can be modified for each viewport.

Look at the upper-left corner of the viewport, and you will see the Viewport Label menus
(Figure 1.86). These three menus provide access to control the characteristics of the selected view.

FIGURE 1.86
The Viewport Label Graphi eling Tools
menus

General Shading
Point-0f-View (POV)

In the following exercise, you'll see how you can alter viewport settings to obtain specific
view characteristics such as shading and perspective:

1. Move the cursor and hover over the Shading Viewport Label menu, which is the right-
most set of brackets in the upper-left corner of the viewport. The label inside the brackets
turns yellow. Now click the label. A context menu appears, as shown in Figure 1.87.

FIGURE 1.87
Shading Viewport Realistic Shift«F3
label menu Shaded

Consistent Colors b

Edged Faces

Facets

Hidden Line
Wireframe
Bounding Box

Clay

Stylized

Lighting and Shadows
Materials

Viewport Background

Cenfigure...
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2. Select Wireframe from the menu. The chairs now appear as wireframes (see Figure 1.88),
just as they do in two of the other viewports.

3. Click the Orthographic viewport Shading label again, and then select Hidden Line from
the context menu. The Orthographic viewport changes to reflect the contents in the
Hidden Line rendering mode.

4. Zoom into the chairs to get a better look at the Hidden Line rendering mode. Your view
should be shaded similarly to Figure 1.89.

FIGURE 1.88 [+1[Orthagraphic ] [w
The Orthographic
viewport in
Wireframe mode

FIGURE 1.89 [+ [Orthagraphic ] [Fidden Line ]
A single chairin
Hidden Line render-
ing mode

The context menu is the same for both the Orthographic and Perspective viewports. This
menu gives you control over the display characteristics of the viewport. Try a few of the other
options in the Viewport Label menus:

1. Click the Point-Of-View (POV) label, select Perspective, and then click the Zoom Extents
button. The Orthographic viewport changes to a Perspective viewport. Notice that the
label changes to read Perspective, so that you now have two Perspective viewports, as
shown in Figure 1.90.
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FIGURE 1.90
Two of the four
viewports are
now Perspective
viewports.

2. Click the POV label of the upper-left viewport, select Top, and then click Zoom Extents.
The view changes back to the original top view. Notice that the chairs are still in Hidden
Line mode.

3. Click the Shading label of the Top viewport, and then select Wireframe.

Three of the viewports show wireframe views of the chairs. Wireframe views are best for
many types of editing operations. Wireframes also redraw faster when your model is very large
and full of complex geometry. Another type of view, called a bounding box, is even faster than
a wireframe view, but bounding-box views reduce the representation of objects to rectangular
boxes. The Edged Faces mode, available when the viewport is in any of the available Shaded
modes, displays both the Shaded mode and the edges of the visible objects.

Besides changing the way the viewport displays your model, wireframe view also gives you
control over the layout of the viewports themselves. The following exercise shows you the vari-
ety of layouts you can create in 3ds Max:

1. Choose Views > Viewport Configuration. The Viewport Configuration dialog box
appears, as shown in Figure 1.91.

2. Click the Layout tab. You see the current viewport layout at the bottom of the tab. Above
it is a set of 14 predefined layouts, as shown in Figure 1.92.

3. Click the layout that looks like three small rectangles stacked on the left side with one
large rectangle on the right.

4. Click OK. The viewports change to the selected layout.

5. Click the Zoom Extents All button to zoom all the viewports to show the contents of the
scene. Your viewports should look similar to the viewports in Figure 1.93.



FIGURE 1.91
The Viewport
Configuration
dialog box

FIGURE 1.92
The Layout tab
of the Viewport
Configuration
dialog box
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FIGURE 1.93

The viewports after
changing the
viewport layout

You aren’t limited to the canned layouts either. You may decide that you want the layout
to reflect a more traditional mechanical drawing layout, with top, front, and right-side views.
Here’s how you can set up such a viewport arrangement:

1.
2.

Choose Views > Viewport Configuration.

With the Layout tab selected, click the layout showing four equal viewports, which is the
rightmost layout in the bottom row of layout options.

Click the sample viewport labeled Front in the upper-right corner of the large sample lay-
out, and select Perspective in the pop-up menu, as shown in Figure 1.94.

Click the sample Perspective viewport in the lower-right corner, and select Right from the
pop-up menu.

Click the sample Left viewport in the lower-left corner, and select Front from the pop-up
menu.

Click OK. Now you have a layout that shows the Top, Front, and Right viewports, plus a
Perspective viewport arranged in a more traditional manner. Change the Right viewport
to Wireframe mode and the Perspective viewport to Shaded. Perform a Zoom Extents All,
and your viewports should look like Figure 1.95.

As you can see from what you've learned so far, 3ds Max 2013 provides a wide array of dis-
play options, but most of the time you’ll stick with one viewport layout that you find comfort-
able. For the purposes of this book, you'll use the default layout that shows the four equal-size
viewports.

Before you conclude your tour of the 3ds Max interface, take a look at how the Move tool acts
in the non-Perspective viewports. The following exercise will give you a feel for the ways that
you can use multiple viewports.
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FIGURE 1.94
Changing a specific
viewport’s view
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FIGURE 1.95

The four-viewport
layout with
modifications

1. Click the Select And Move tool.

2. Click and hold to open the Selection Region flyout, and select Rectangular Selection
Region.
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3. In the Top viewport, click and drag the cursor from a point above and to the left of the
bottom row of chairs.

4. Drag the selection region below and to the right of the two chairs in the lower row,
as shown in Figure 1.96, so that they are enclosed in the rectangle. The two chairs are
selected.

FIGURE 1.96
Drag a selection
region around the
lower chairs.

5. Right-click in the Right viewport.

RIGHT-CLICKING RETAINS THE SELECTION SET

By right-clicking in a viewport, you can make it active without disrupting any selections that may
be active at the time. It is a good habit to just right-click to switch active viewports.

6. In the Right viewport, click and drag the green Y-arrow upward. Notice how the chairs
move in the Front and Perspective viewports as you do this.

7. Position the chairs so that they are higher by about one-half the height of a chair.

8. Click and drag the red X-axis of the chairs to the right of the screen so that they merge
with the chair to the right, as shown in Figure 1.97.

9. You can save or discard this file. You won’t need it anymore.

In this exercise, you saw a number of methods in action. First, you saw how to use the Select
And Move tool to select objects as well as move them. This can help you move objects quickly by
reducing the number of clicks you need to make. Be careful, though; you might select and move
the wrong object when you are in a hurry. Next, you saw how you can right-click in a viewport
to make it active. Had you simply clicked in the Right viewport in step 4, you would have lost
the selection set you created in step 3.
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FIGURE 1.97 [-+ 1 [Right T [Witefeame1
Move the selected
chairs along the
X-axis.

Finally, you saw how objects in 3ds Max don’t conform to one of the basic rules of physics. In
3ds Max, more than one object can occupy the same space at the same time. This characteristic
can be extremely useful in a number of ways as you build models in 3ds Max 2013.

Working with the Custom Ul And Defaults Switcher

The Custom UI And Defaults Switcher provides an easy and unified method for managing all
the myriad preference settings within 3ds Max. Let’s explore what the Custom UI And Defaults
Switcher has to offer.

1. Choose Customize > Custom UI And Defaults Switcher, as shown in Figure 1.98

FIGURE 1.98 Customize =~ MAXScript  Help
The Customize 3 Customize User Interface...

menu
Load Custom UI Scheme...

Save Custom Ul Scheme...
Revert to Startup Layout
Lock Ul Layout

Show Ul
Custom Ul and Defaults Switcher...

Configure User Paths...
Configure System Paths...

Units Setup...

Plug-in Manager...

Preferences...

2. Click the DesignVIZ item in the Initial Settings For Tool Options group in the upper-left
corner of the dialog box to see the settings listed in Figure 1.99.
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FIGURE 1.99
Custom Ul And
Defaults Switcher
settings

Initial settings for Design & Visualization

Overview

The Design & Visualizafion initial settings are configured to provide as much rendering performance as
possible with large scenes, containing many lights. Your application will be directed towards photo
realistic rendenng of typical architectural models.

Layers: all objects are created "By Layer”.

Material Editor: populated with Architectural matenials, displays reflactance and transmittance
information [more below]

Lights: all cast raytraced shadows.

Daylight: defaults to IES sun and sky.

Rendering: using the Default Scanline renderer, with radiosity pre-assigned, and no exposure controls,
Motion Blur: none of the objects will generate motion blur.

Clening: objects are instanced by default

Select By Name: display children is enabled,

i+drop: maps are copied from the i-drop source to the /Adownlfoads/ folder .

Inverse Ki ics: optimized for interact i i

Viewport Shading: optimized to support many light sources.

Real-World Texture Coordinates: Sel to suppor real-world scaling of UVW coordinates,

Layers All newly created objects will take advantage of the Layers -

3. Scroll down in the dialog box, and read through the changes that the DesignVIZ settings
represent in the HTML file that is part of the dialog box. There are five possible settings
for tool options: Max, Max.mentalray, DesignVIZ, DesignVIZ.mentalray, and DesignVIZ.
iray.

The DesignVIZ settings are configured to provide the 3ds Max user with good render-
ing performance in large scenes with many lights; this assumes that you'll be using the
Default Scanline Renderer with the Radiosity Advanced Lighting plug-in and photomet-
ric lights.

The DesignVIZ.mentalray initial settings are meant to be used in conjunction with the
NVIDIA mental ray renderer. Each of these settings automatically configures multiple
preferences in Layers, the Material Editor, Lights, Daylight System, Rendering, Motion
Blur, Cloning, Select by Name, Inverse Kinematics, Viewport Shading, and Real-World
Texture Coordinates. The Max and Max.mentalray initial settings are designed for use
when utilizing 3ds Max for game, film, and video production.

On the right side of the Custom UI And Defaults Switcher dialog box, you'll see a default list
of UI schemes. Here you can conveniently select which UI scheme you'd like to use. UI schemes
hold all the customizations you can make to the keyboard hotkeys, toolbar, quad menus, stan-
dard menus, and color schemes in one place. To make changes to an existing Ul scheme, you'll
use the Customize User Interface dialog box.

1. Click Cancel since you will be using the default 3ds Max settings for the majority of the
exercises in this book.
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2. Choose Customize > Customize User Interface to display the dialog box shown in
Figure 1.100.

FIGURE 1.100
The Customize User
Interface dialog box

3. Click each of the tabs at the top of this dialog box to become familiar with all the ways
that you can customize your user interface. Changes can be made to the keyboard short-
cuts, mouse buttons, toolbars and buttons, quad menus, all pull-down menus, and inter-
face colors. If you do decide to make any changes, simply click the Save button on the tab
in this dialog box to record your specific changes to disk, as shown in Figure 1.101. Each
tab saves as a different file type that controls different aspects of the user interface.

4. Choose Customize > Save Custom UI Scheme. Open the Save As Type drop-down list,
shown in Figure 1.102. You will notice five different file formats that can be saved (and
loaded) through Save (and Load) Custom UI Scheme from the Customize menu. Each one
of the lower four formats — Ul File (*. cui), Menu File (*.mnu), Color File (*.c1r), and
Shortcut File (*. kbd) — corresponds to each of the tabs in the Customize User Interface
dialog box — Toolbars and Quads, Menus, Colors, and Keyboard, respectively. Note that
the mouse customizations are not listed and that these are all the legacy customization
file formats. If you want to save your customizations with the current formats, you must
use the Save buttons on the six tabs of the Customize User Interface dialog box.

FIGURE 1.101
Saving the
customization
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FIGURE 1.102
The Save Custom Ul s |
Scheme dialog box RS C: \Users | Jeffrey \AppData \Local \Autodesk |\ 3dsMax 20 13 - 64bit\ENU\en-US\UI\Workspaces\usersave v

|, usersave

Date modified Type

Neo items match your search,

When you choose to save the first format in the Save Custom UI Scheme dialog box
(Interface Scheme format), you are saving a composite file that contains all the customiza-
tions present in all the other formats combined. It is this Interface Scheme format (*.u1)
that is displayed in the UI Schemes portion of the new Custom UI And Defaults Switcher.

Close the Save Custom UI Scheme dialog box without saving any files.

WARNING You will need to reset your 3ds Max 2013 configuration back to the defaults at the
conclusion of the following exercises in order for the exercises in the rest of the book to work as
written.

The Bottom Line

Navigate and configure the viewports. The 3ds Max viewports can be configured in sev-
eral ways, including setting the quantity and configuration of the viewports.

Master It Configure the viewports so that there are three small viewports stacked

on the left side and one larger viewport on the right. From top to bottom, set the three
stacked viewports to Top, Front, and Right, respectively; then set the large viewport to a
Perspective viewport.

Dock and float toolbars. The 3ds Max user interface has several customizable features,
including the ability to hide or expose and dock or float the program’s toolbars.

Master It Detach the Command panel from the right side of the 3ds Max window, and
release it so that it floats in the middle of the 3ds Max window. Select the Command
panel again, and attach it to the left side. Expose a hidden toolbar, and dock it to the left
of the Command panel.

Copy objects and use the transform tools. The transform tools (Move, Rotate, and Scale)
are the most commonly used tools in 3ds Max. With them, you can position, orient, and scale
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your objects as required in the scene. You can quickly create a copy in 3ds Max, a process
called cloning, by holding down the Shift key while using any of the transform tools.

Master It Make a box that is 3" long, 10" wide, and 8" high. Make five instance clones of
the box, and rotate each clone 20 degrees more than the previous clone. Stack the boxes
like a spiral staircase, with an increasing amount of swing with each stair and leaving no
vertical or horizontal gaps in the stairs.

Create a named selection set. Whenever any objects are selected in 3ds Max, the selected
objects are referred to as a selection set. Often, you may need to select the same objects repeat-
edly for different operations. By creating named selection sets, you can quickly select objects
by selecting the selection set name from a drop-down list.

Master It Continuing from the previous “Master It” exercise, rename the boxes to
Stepl, Step2, Step3, and so on, starting with the bottom step. Make and test two named
selection sets — one containing the lower three steps and another containing the even-
numbered steps.
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